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1 Customer information 

1.1 Carlson Software 

Congratulations on purchasing a laser scanning system from Carlson Software.  
 
Founded in 1983, Carlson Software specializes in CAD design software, surveying hardware, and machine control 
products for the land surveying, civil engineering, construction, and mining industries worldwide, providing one-
source technology solutions from data collection to design to construction.  
 
The C-ALS and VS+ are designed and built with Carlson’s world-class levels of detail, quality and innovation.   
 
Carlson’s renowned dedication to customer service is unique in the industry. 
 
For any technical support issues related to your hardware or software contact us directly or, alternatively, contact 
your local Carlson-approved service and support centre. Details of all contacts are on our website:  
www.carlsonsw.com. 

1.2 About this manual 

This manual is concerned with Carlson Scan software. Carlson Scan is designed to connect directly to Carlson’s 
C-ALS and VS+ instruments.  
 
Since the software is so integral to the use of both scanners, sections 0 and 18 of this manual details typical, in-
field deployment procedures together with a discussion of the navigational abilities and limitations of the C-ALS and 
VS+. 
 
There are companion manuals dedicated to the C-ALS and VS+ hardware. These hardware manuals detail the 
system components, accessories and safety and certification information. It is important that both the hardware and 
software manuals are read carefully before deploying one of Carlson’s scanners on site. 
 
This Carlson Scan manual has been compiled with care. However, should you discover any errors, we would be 
grateful if you could contact Carlson directly.  
 
For any feedback or comments, or if there are questions about the software which are beyond the scope of this 
manual, contact Carlson support. Contact details can be found on the back cover of this manual. 
 
Alternatively, for information on your local Carlson approved dealer, visit our website www.carlsonsw.com.  
 
Carlson has made considerable efforts to ensure the content of this document is correct at the date of publication 
but makes no warranties or representations regarding the content. Carlson excludes liability arising from any 
inaccuracies in this document. 

1.2.1 Manual version 

The document number of this manual is 3.2. Compiled in January 2024. 
 
The manual is based on Carlson Scan software version 1.7.65. 
 
 
Manual version 3.2 

 Tidy of formatting and references throughout. 

 ‘Calibration’ changed to ‘Alignment’ throughout to match software terminology changes. 
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 Added joystick control panel and explanation (see section 11.6). 

 Updated screenshots to reflect UI changes. 

 Removed licensing information. 

 

1.2.2 Trademarks 

Carlson and the symbol used in the Carlson logo are registered trademarks of Carlson in the USA and other 
countries. Break new ground and names and designations of other Carlson products and technologies are 
trademarks of Carlson or its subsidiaries. 
 
Any other brand names and product names used in this document are trade names, trademarks, or registered 
trademarks of their respective owners. 
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2 Hardware and software 

2.1 VS+ 

The VS+ is optimized for scanning underground stopes. The VS+ can be mounted on booms, tripods or customised 
deployment devices. 
 
Prior to scanning, the VS+ is secured in place inside the stope. Prims mounted on the unit and on the back of the 
boom are surveyed using traditional survey techniques. This defines the position and heading of the instrument. 
This information is combined with data from inclinometers inside the VS+ to ensure all scanned data is correctly 
orientated and positioned.  
 
The VS+ laser moves automatically, driven by Carlson Scan software, to survey the void. 

2.2 C-ALS 

Carlson’s C-ALS is tubular in design and has a diameter of just 50 mm. This allows the instrument to be deployable 
into voids via drilled boreholes. The C-ALS can be deployed up to 200m before being secured in place to scan a 
void it has entered.  
 
A motorised 2-axis scanning head ensures a complete 360° scan covering the entire scene, even looking back to 
where the C-ALS has entered the void. 
 
This manual is focused on variants of C-ALS probes which incorporate an IMU: either a C-ALS Gyro or a C-ALS 
HD. The IMU incorporates a triaxial gyro and accelerometers. Data from these sensors is collected at regular 
intervals as the probe is being deployed. This ensures that an accurate model of the deployment route can be 
created and also that the C-ALS is correctly positioned and orientated when it is scanning.  
 
If the borehole collar coordinates are known, this anchors all the collected data in a real-world location and each 
point in the resulting ‘point cloud’ can be correctly geo-referenced. 
 
A borehole camera is integrated into the nose of the C-ALS. A feed from this camera aids deployment and helps to 
determine the optimum position of the scanner as it protrudes form the borehole, ready to scan. 

2.3 Carlson Scan software 

Both the C-ALS and the VS+ are operated remotely which ensures that personnel can remain in safe locations 
away from unsafe areas.  
 
The scanners are controlled from a tablet PC or laptop running Carlson Scan software. Carlson Scan recognizes 
whichever instrument is plugged into the tablet and customizes the user interface and functionality accordingly. 
 
Carlson Scan allows you to manage the deployment and georeferencing of the scanner and to initiate scans. All 
data from the instrument – from the navigation sensors, the borehole camera and from the laser – is visualised on 
screen in real-time, ensuring that immediate assessments can be made of the deployment, the data quality and of 
the area being scanned. 
 
Different modes of Carlson Scan optimize the software for data collection and for data analysis. The collected data 
can be edited, transformed, combined with other datasets and exported to third-party software.  

2.3.1 Changes to Carlson hardware and software 

Carlson reserves the right to improve, change or modify its products and documentation without incurring any 
obligation to make changes to equipment previously sold or distributed. 
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CARLSON SCAN 

SOFTWARE 
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3 Getting started 

3.1 Equipment compatibility 

Carlson Scan software is designed to work with C-ALS and VS+ instruments supplied by Carlson. 
 
The exact compatibility is as follows: 

 All C-ALS Gyro units are compatible (excluding C-ALS Gyro units produced by Renishaw). 

 All C-ALS HD units are compatible. 

 C-ALS Mk3 units are not supported to beyond Carlson Scan version 1.3.6. 

 All VS+ units produced by Carlson.  

 Void Scanner units are not supported by Carlson Scan v.1.7.14 and above. 

If you have any doubts as to the compatibility of Carlson Scan with your instrument, please contact Carlson for 
further details.  

3.2 Tablet requirements and compatibility 

Carlson can supply VS+ and C-ALS systems packaged together with a recommended field tablet computer. The 
tablet is pre-installed with Carlson Scan software and pre-configured to optimize performance. 
 
Alternatively, if you are independently selecting a Windows-based tablet or laptop to run Carlson Scan, consider 
the following points when making your choice.  
 
Carlson Scan Touch mode is optimized for use on a touch screen tablet with a screen size of around 10.1”, 
although it will run on smaller screen sizes if required.  
 
Carlson Scan Desktop mode is designed to be used in an office environment in conjunction with a standard mouse 
and keyboard.  
 
Any tablet used in the field should be highly ruggedised to withstand the harsh conditions that are typical for the 
applications in which the scanning hardware is used. 
 
For field use, the battery life of the tablet should also be considered to avoid the tablet running out of power during 
a deployment. Taking an inverter into the field can allow the tablet to be plugged into a battery or a vehicle 12V 
supply via its standard mains power supply adaptor. 
 
Carlson Scan runs on 64-bit Windows PCs from Windows 7 upwards. 
 
300 MB free space is required on your tablet’s hard disk to install the software. 
 
2 GB is the minimum recommendation for RAM installed in your tablet. 
 
The main compatibility requirement for Carlson Scan to run is that the processor / GPU should be able to support 
Vulkan API. A list of processors and GPUs compatible with Vulkan in Windows, is shown here: 
https://en.wikipedia.org/wiki/Vulkan_(API)#Compatibility. 
 
Carlson recommends that you ensure that all Windows updates are current and that the latest drivers for your 
graphics card are installed. Failure to update components may result in video or driver errors. 
 
To connect to the C-ALS, an Ethernet port and/or a Wi-Fi card is required in your tablet.  
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To connect to the VS+ you require a Wi-Fi card in your tablet. 
 
Both the C-ALS surface unit and the VS+ communicate wirelessly via a 2.4 GHz connection. Later models also offer 
a 5 GHz link. If your tablet hardware supports 5Ghz Wi-Fi, you may use this frequency to counter any interference 
or connectivity issues you may experience with the default 2.4 GHz connection. 

3.3 Software installation 

Carlson Scan has a non-restrictive distribution license, so it may be installed on as many tablets as required. 
 
If you ordered a rugged tablet from Carlson as part of a C-ALS purchase, Carlson Scan is already loaded on the 
tablet. 
 
If you are supplying your own tablet, you must install the software before using your scanner for the first time. 
 
The Carlson Scan installer is loaded onto the USB drive packaged with all C-ALS systems. Updates are made 
available online. 
 
The installer is supplied in the form of an *.exe file or, optionally, an MSI file. Double-click on the file to run the 
installer. 
 

 
Click Install, Next and then accept the license after a careful review.  
 
Click Install. The software and all necessary dependencies are loaded onto your tablet. 
 
By default, Carlson Scan is installed at: C:\Program Files\NDEVR\Carlson Scan\. 
 
An icon is loaded onto your desktop. Double-click to open Carlson Scan. 
 

 

Carlson Scan installer 

Carlson Scan desktop icon 
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3.4 Software updates 

Always use the most recent released version of Carlson Scan. This is available from Carlson website downloads 
page here: 
 

https://web.carlsonsw.com/files/updates/updates05.php?ss_email=&product=CarlsonScan 
 
The latest version of the software is available at this location, together with the relevant software and hardware 
manuals. 
 

 
At the bottom of the download page enter your name and email address and click Update. You will be sent an email 
notification whenever a new version of Carlson Scan is released.  
 

 
The first step of any troubleshooting process is to ensure that you are using the current release of Carlson Scan 
software. 

  

Carlson downloads page 

Enter details for update notifications 
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3.5 Data storage and file formats 

A Carlson Scan project is saved as an *.NDV file. You can open this file from within Carlson Scan by using the 
Open function. Alternatively, double-click on the file in Windows Explorer to automatically open the selected project 
inside Carlson Scan. 
 
By default, projects created in Carlson Scan are saved in the location:  
 

C:\Users\<username>\Documents\Carlson Scan\<projectname>. 
 

 
The default location can be changed through the Settings window (see section 4.3.6). 
 
Note that before you manually save the project, it is automatically saved in the temporary location: 
 

C:\Users\<username>\Documents\Carlson Scan\Unsaved Projects\<projectname>. 
 
Once you have manually saved the project, it is moved to the default Carlson Scan directory. 
 
Other files are stored in sub-folders underneath the Carlson Scan\<projectname> directory: 

 Backup: while a project is active, a backup file is stored here and continually updated. This ensures all data 
is secure and allows recovery in case of a hardware or software failure. Files in this folder are time/date 
stamped with <most_recent.ndv> being the last recorded backup.  

 Exports: by default, any exports generated from a project are stored here.  

 Logs: during data collection operations, detailed logs are kept of communications with the scanner. These 
may be used for support and troubleshooting. 

 Screenshots: snapshots taken with the C-ALS borehole camera are stored here. 

 Video: videos taken with the C-ALS borehole camera are stored here. 

If problems are encountered with the hardware, software or any collected datasets, then it may be necessary to 
contact Carlson for support. In this case you may be requested to send the *.NDV file for further analysis and 
troubleshooting. This will help to ensure the highest level of support. 
 
Access the project location from within Carlson Scan by tapping Browse in the Menu tab (see section 6.7). 
Windows File Explorer opens at the address of the active project. 

  

A Carlson Scan project in Windows Explorer 
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3.6 Viewing modes 

Carlson Scan is designed to be used with a choice of two viewing modes: Touch and Desktop. 
 
The mode can be selected when starting up the software. A Desktop button is available on the Touch mode Home 
screen (section 4.9). A Touch button is available in the Desktop tool bar when first starting the software (section 
13).  
 
The option to swap modes is only available prior to opening an existing project or starting a new project. Once a 
session has begun, to swap modes, close the software down and reopen to access the relevant button. 
 
Unless specified, screenshots in this manual show Carlson Scan being used in Touch mode. 

3.6.1 Touch mode 

Touch mode is optimised to be used on a touch-screen tablet. It is recommended that Touch mode be used when 
collecting data in the field. The relevant controls for connecting to, and controlling, the scanner are made easily 
accessible through large format buttons. Features less used in the field are kept clear from the main interface. Some 
functionality such as editing is not available in Touch mode. 
 
In Touch mode, dedicated on-screen keyboards and number pads appear at any time manual data entry is required.  
 
The keypads include buttons to progress to the next field or to go back to the previous field. The number pad can 
also be used as a calculator if required. 

3.6.2 Desktop mode 

When a project has been completed, the data is usually viewed and analysed back in the office. In this case, if you 
are using a larger format laptop or desktop computer then select Desktop mode. 
 
Desktop mode has a more traditional interface and is intended for use with a standard keyboard and mouse. 
 
Desktop mode makes use of extra screen space by making more information available on-screen, and by allowing 
multiple viewing windows to be shown simultaneously.  
 
More functionality for editing the data is accessible through the Desktop mode (see section 13). 
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4 Touch mode – Home screen 

When Carlson Scan is first opened in Touch mode, the Home screen appears. 
 

4.1 Start 

Tap Start to create a new, Carlson Scan project.  
 
The Project window opens (see section 7.1). Edit the details as required. You can enter hole positions in advance, 
give the project an appropriate name and change the default folder location.  
 
By default, the project is named <Project YY-MM-DD HH MM>. 
 
Tap Create to accept the entered details and create a new project. 
 
Carlson Scan immediately runs an auto-detect process to identify a C-ALS or VS+ scanner which has been paired 
to the tablet and which is currently powered ON.  
 
When a scanner is identified, the connection is made.  
 
The Station Details window appears (see section 7.2.1). Enter your station coordinates, or just accept the default 
values. Tap Finish. 
 
The main Touch mode interface appears with the 3D View on the left-hand side of the screen and the Control tab 
on the right-hand side. 
 
The scanner is displayed graphically on screen, located at the newly generated station. The deployment is now 
ready to begin 
 
See section 10.1 for connecting to the VS+ and section 11.1 for connecting to the C-ALS. 

Touch mode Home screen 



 

P a g e  | 15 

To import existing data into the project, open the Menu tab and select Import (see section 6.3). 

4.2 Open 

From the Home screen, tap Open to open an existing Carlson Scan project. An Open dialog appears.  
 
Select the appropriate project from the recent files list. Alternatively, tap Browse Files to open an Open File 
windows dialog. Browse to the project location and select the *.NDV file to open the project in Carlson Scan. 
 
On opening a project, you can reconnect to a scanner via the Find Scanners button on the Control tab (see 
sections 10 and 11). 

4.3 Settings 

Tap Settings to view or edit software configuration settings. The Settings window appears.  
 
There are tabs along the side of the screen which group together different categories of controls. 

4.3.1 General 

The General tab collects together settings affecting the general operation of Carlson Scan software. 
 

 

 User name: enter the name of the operator. This appears on reports and saved project information. 

 Field mode: Toggle ON to optimise Desktop mode for data acquisition in the field. This ensures appropriate 
defaults are set for sounds, auto-connect to devices, full screen mode etc. Alternatively, if using Desktop 

Settings window > General tab 
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mode for post-processing data in the office, switch Field mode OFF.  

 Use GNSS/Projections: this feature allows Carlson Scan to interact with a GNSS device to survey the 
position of collar coordinates. Toggle ON the Use GNSS/Projections switch to enable GPS functionality. 

 Default Record Steps: for troubleshooting, toggle ON to activate Windows Steps Recorder. This activates 
a recording of all interactions with the software. 

 Language: select from the list of available language options. If you would like to see additional language 
options in the list, please contact Carlson to make a request. 

 Updates: Check for update automatically checks for new versions when the tablet is connected to a 
network. If a new version is available, hit the update button to download and update the software version. 

 Debugging defaults: for troubleshooting purposes only. 

 Reset to Factory Defaults: restores Carlson Scan software to the state of a fresh installation. 

 Create Background: creates a ‘Carlson’ desktop wallpaper for your device. 

 

4.3.2 Scan 

The Scan tab allows you to configure some default settings for scanning operations. 
 

 

 Show mesh: set as default whether the mesh is visible or invisible when a scan is running. 

 Show points: set as default whether the points are visible or invisible when a scan is running. 

 Mesh wireframe: set as default whether the mesh is visible as a wireframe, or as a solid surface. 

Settings Window > Scan tab 
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 Mesh two-sided: set as default whether the mesh is visible as a two-sided surface, or with the near side 
invisible. 

 Always show range: set as default whether a red laser line, indicating the path of the laser, is displayed 
in the 3D View. 

 Primary angle of separation: set the default Scan angle in the Control tab. 

 Passes per sweep: sets the number of times the scan head rotates at each given horizontal/vertical angle 
combination. 

 Scan mode: set the default mode of scanning in the Control tab. 

 Smart scan: set as default whether each scan is ‘smart’. A smart scan attempts to optimise the point 
coverage by reducing scan lines where the laser is pointing at surfaces which are very close and which 
would normally be over-saturated with points. 

 Maintenance password: used for troubleshooting in conjunction with Carlson support personnel. 

 Calibrate scans: set as default to use the gyro information captured during a scan to calibrate the 
orientation and alignment of the scan, after it is complete.  

o Max drift / minute: calibration setting for troubleshooting use. 

o Scan angle tolerance: calibration setting for troubleshooting use. 

o Clear cached probe data: resets probe-specific data which is used for calibrating scans. 

 Secondary angle of separation: sets how dense the mesh triangulation should be when it is created 
during a scan. 

 Scan mesh smoothness: sets the default value which governs a local averaging algorithm which smooths 
the mesh over the point cloud. This can be adjusted to increase or reduce the smoothing. Reducing the 
value can help fill gaps in the mesh. 

 Custom connection address: used for a custom instrument setup with a non-standard IP address.  

 Camera drape image folder: location to store camera images when photo-drape function is in use. 
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4.3.3 Camera 

The Camera Settings tab contains settings related to the on-screen C-ALS video window. It is not usually necessary 
to adjust these values. 
 

 

 Show video during scan: toggle the switch ON to enable the on-screen C-ALS video window to display 
during a scan. If this option is OFF, the video window disappears during a scan. 

 Auto-orientate camera: if toggled ON, the camera is kept orientated while the scan head rotates. 

 Auto-record camera: if toggled ON, the camera image is always recorded while visible on screen. 

 Use Axis server: allows the use of different video servers. 

 Ignore camera: ignores the camera while the C-ALS is connected. The camera image will not be displayed.  

Note that if the C-ALS is being deployed down a borehole, the camera should always be used to detect 
obstructions and to identify the point at which the C-ALS probe enters the void. 

 LED Brightness: use the slider to adjust the brightness of the LED on the nose of the C-ALS. 

 Video server: opens a browser to view the video server’s web UI. This allows direct adjustment of the video 
settings. 

  

Settings > Camera tab 
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4.3.4 Units 

The Units tab allows you to set the units of measurement for your project. 
 

 

 Metric: tap to set all units to default metric measurement units. 

 Imperial: tap to set all units to default imperial measurement units. 

 Select the coordinate system from: 

o ENH: Easting, Northing, Height (x, y, z) 

o NEH: Northing, Easting, Height (y, x, z) 

o WSH: Westing, Southing, Height (x, y, z) 

o XYZ: Easting, Northing, Height (x, y, z) 

o YXZ: Northing, Easting, Height (y, x, z) 

 Unit: select from: 

o Metres 

o Feet 

o US Survey Feet 

o Inches 

o Centimetres 

 Surface area unit 

Settings window > Units tab 
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o Square Feet 

o Square Metres 

o Square Yards 

o Square Inches 

o Square Kilometres 

 Volume Unit 

o Cubic Feet 

o Cubic Metres 

o Cubic Yards 

o Cubic Inches 

o Litres 

o US Gallons 

 Angular unit: 

o Decimal degrees 

o Degrees minutes 

o Degrees, minutes, seconds 

o Radians 

o Gradians (gons) 

 Heading: define the 0° reference direction: 

o North 

o East 

o South  

o West 

 Define the direction of horizontal angle measurement: 

o Clockwise 

o Anti-clockwise 

 Inclination Unit: define the angle define by a horizontal inclination: 

o Horizontal = 90° 

o Horizontal = 0° 

 Define the direction of vertical angle measurement: 

o Upward positive 

o Downwards positive 
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 Deployment Length: define the units used to deploy the C-ALS: 

o Meters 

o Feet 

o US Survey Feet 

o Inches 

o Centimeters  

 

4.3.5 Projection 

The Projection tab allows you to set the geodetic parameters of the GPS data being used. 
 

 
Select the appropriate coordinate system for your project. The streamed GNSS position is converted into the 
selected datum for display and recording within your Carlson Scan project. 
  

Settings > Projection 
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4.3.6 Folders 

The Folders tab defines the storage location of Carlson Scan projects on your tablet.  
 

 
By default, Carlson Scan uses project folders, as described in section 3.5. The Use Project Folders radio button 
is selected by default.  
 
To change the default location in which projects, logs, exports or backups are stored, tap the appropriate Choose 
Folder button under Project Root Folder.  
 
Alternatively, select Use Project Files to store each project and associated files in separate folders. In this case, 
by default, files are stored in the folder listed below, but can be changed. 

 Project Root Folder: stores the main NDV project file. 

 Log Folder: stores the log files for troubleshooting & diagnostics. 

 Default Export Root: stores data files exported from the main project. 

 Backup Folder: stores ongoing backup files which ensure that no data is ever lost. 

 
Use the value in the Auto Save Duration text box to define how often the current project is automatically saved. 
By default, the project is auto-saved every five minutes. 

Settings window > Folders 
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4.3.7 Interface 

The Interface tab collects settings which determine the appearance of Carlson Scan on your tablet. 
 

 

 UI scale: select a scale to ensure a best fit for Carlson Scan on your tablet. 

 Text scale: select a scale to ensure a best fit for Carlson Scan on your tablet. 

 Animation Speed: control the appearance of transitions between various tabs, controls, and windows. 

 Icon pack: change the appearance of all icons though out Carlson Scan. 

 Screen layout – Bottom section: in Desktop mode, activates a frame at the bottom of the screen for scan 
information. 

 Screen layout – tabs on left: position tabs on the left-hand side of the screen. 

 Screen layout – tabs on right: position tabs on the right-hand side of the screen. 

 Touch settings – Keypad: activate the onscreen keypad for data entry. 

 Touch settings – Fullscreen: toggle between fullscreen mode and window mode. 

 Touch settings – Sound: toggle sound affects ON and OFF. 

 Touch settings – Vibration: toggle vibration ON and OFF. 

 Touch settings – Speech: toggle spoken reports during a deployment ON and OFF.  

 Touch settings – Show exit: enable or disable the Exit button in the Menu tab and the Home screen. 

Settings window > Interface 
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4.3.8 Graphics 

The Graphics tab defines default settings for the visualisation of data in the 3D View. 
 

 

 Pixel thickness: change the thickness of lines displayed in the 3D View. 

 Near plane: the closest distance from your viewpoint that is rendered in the 3D View. 

 Far plane: the furthest distance from your viewpoint that is rendered in the 3D View. Large distances can 
be displayed but may be at the expense of the rendered resolution. 

 Frame rate: the number of frames to be displayed in the 3D View per unit of time is expressed in frames 
per second (fps). 

 Anti-aliasing: by default, the anti-aliasing check box is ticked on. You may wish to untick the check box if 
you are troubleshooting graphics display issues on your mobile device. 

 Default colours: select the colours which are used to shade the survey data and models in the project. 
Background selects the background colour for the 3D View. The Max, Mid and Min values refer to different 
qualities depending on the colour scheme selected. 

  

Settings window > Graphics tab 
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4.3.9 Station 

The Station tab deals with default settings for station creation. A Station is a hole collar from which the C-ALS is 
deployed, or a surveyed position of the VS+. All settings can also be configured on an individual hole-by-hole basis 
through the Station Details window (see section 7.2.1).  
 

 

 Default station coordinates: sets the coordinates which are used when a station is automatically 
generated by Carlson Scan. These can be changed at any time before or after a survey. You may find it 
convenient to enter default station coordinates which are close to those on your project coordinate system. 

 Enabled Heading Options: toggle ON or OFF the following options depending on your standard field 
procedures. When toggled ON, they appear as an option in the Alignment window: 

o None: heading is set to zero. 

o Known Heading: manually enter a heading value. 

o Back Point: manually enter a ‘back point’. A heading is computed from the back point to the 
currently selected hole collar.  

o Two Point: manually enter a back point and a front location. A heading is computed from the back 
point to the front location.  

o Relative: Select two pre-defined stations. A heading is computed between the two stations. 

 Optional features: 

o Show line of sight: toggle ON to investigate sight lines when working with pre-surveyed point 
clouds or surfaces. 

o Custom prism: toggle ON to use a non-standard prism position when using a VS+. 

 Station text: controls the default appearance of stations created in Carlson Scan. 

Settings > Station 
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o Show title: display the station name in the 3D View. 

o Show ranges: display range label on the range circles / grids around the station. 

o Show axes: display labels on axes centred on the station. 

 Station linework: controls the default appearance of stations created in Carlson Scan.  

o Show ranges: display range circles / grids around the station in the 3D View. 

o Show axes: display axes centred on the station. 

o Max radius: the maximum size of the Station in the 3D View. 

 

4.3.10 Imports 

The Imports tab lists all file formats which can be imported into Carlson Scan. Tap on any import to define default 
options for each format. These settings can also be altered during each individual import. 
 

4.3.11 Exports 

The Exports tab lists all file formats which can be exported from Carlson Scan. Tap on any export to define default 
options for each format. These settings can also be altered during each individual export. 
 

4.3.12 Keystrokes 

The Keystrokes tab lists common actions in Carlson Scan and allows you to assign shortcut keys to each of these 
actions. This enables you to utilise hardware buttons on your mobile device to activate actions such as taking a 
reading or finishing a hole. 
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To assign a shortcut key, tap on any of the existing shortcut buttons in the Keystroke tab. Press the button or 
combination of buttons you would like to use for the associated action. This shortcut now replaces the previous 
shortcut key. 
 
You can assign the same button to actions which are encountered at different stages of a deployment operation. 
For example, a Function key may be assigned to ‘Take Reading’ and also to ‘Download Data’ as these actions are 
never offered as onscreen options at the same time. 
 

4.3.13 Modules 

The Modules tab lists the software modules present in your version of Carlson Scan. 

  

Settings > Keystrokes 
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4.4 About 

Tap the About button to access help documentation and program information. There are three tabs along the top 
of the window. 

4.4.1 About 

The About tab displays details of Carlson Scan including the version number which should be quoted during any 
support query to Carlson. 
 

  
The version number of the software is shown in the About screen and should be quoted during any support call 
with Carlson. 
 
If your tablet is connected to the internet, use the Check for update button to check whether you are using the 
most recent version of Carlson Scan. 

4.4.2 Manuals 

The Manuals tab provides access to this Carlson Scan software manual, as well as to the hardware manuals of 
all products supported by the software. 

4.4.3 License 

The License tab displays the end-user license agreement. 

4.4.4 Modules 

The Modules tab lists the software modules present in your version of Carlson Scan. 

  

About window > About tab 
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4.5 Light / Dark / Black 

Tap Dark / Light / Black to toggle between three colour themes. During in-field operations, whether it be 
underground or in bright sunlight, one particular theme may give a clearer view of the screen. 
 
You may also need to change the background colour to improve visibility in certain lighting conditions (see section 
4.3.7). 
 

 
 

4.6 Desktop 

Tap the Desktop button to change to Desktop mode. Carlson Scan automatically restarts and opens in Desktop 
mode (see section 13). The chance to switch between Desktop and Touch mode is only offered prior to opening a 
project. 

4.7 Exit 

Tap the Exit button to close Carlson Scan. 
 

Light mode, dark mode, black mode 
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5 Touch mode – screen layout 

 
In Touch mode, a standard screen layout is composed of the elements outlined below.  
 
Note that you may use the options in the Settings window to modify the appearance from the default layout shown 
in this manual (see section 4.3).  
 
Also note that the screen will look different depending on which instrument is connected to the software. In the 
image above, Carlson Scan is connected to a C-ALS. 

5.1 3D View 

The main 3D View window shows all data graphically as it collected in real-time. This includes scanned point clouds 
and, for the C-ALS, deployment trails. 
 
Initially the 3D View shares the screen space with one of the function tabs. Retract the active function tab to switch 
the 3D View to full screen (see section 5.4). 
 
Navigation in the 3D View is by intuitive dragging and tapping or, alternatively, by using a mouse. 

 Zoom in / out: pinch / expand gestures with two fingers; roll the scroll wheel on a mouse. 

 Rotate: drag with a finger; click and drag with a mouse. 

 Pan: hold and drag with a finger; click and drag with the right button on a mouse. 

Elements visible in the 3D View are outlined below. 

Touch mode - screen layout 

Selected 
function tab 

Function 
tabs 

3D View 

3D View 
tabs 
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5.1.1 Background colour 

The background colour is black by default. Change the background colour in the Settings window (see section 
4.3.8). 

5.1.2 Scanner model 

A model of the C-ALS or VS+ is shown on screen. The internal sensors allow the model to be correctly positioned 
in real-time, showing the inclination and roll of the scanner. As the scanner head moves, this is also replicated on 
screen.  
 
When the instrument is scanning, a red laser line is displayed to illustrate the direction that the laser is firing. 
 

Graphic elements in the 3D View 



 

P a g e  | 32 

 

5.1.3 Point clouds and meshes 

The point cloud being generated by the scanner appears in real-time in the 3D View window. 
 
As the points are collected, Carlson Scan uses the points to create a mesh in real-time.  
 
The Scan tab contains controls to change the appearance of the point cloud and the mesh (see section 8). 
 
All scans completed in a project can be displayed on screen simultaneously.  
 
The Project tab contains controls to turn the scans and meshes on and off in the 3D View window (see section 7). 

5.1.4 Deployment data 

As the C-ALS is deployed, Boretrak readings are taken. These readings are all visible on-screen as they are 
recorded.  
 
You can thus trace the deployment of the C-ALS from the collar to the scan location and visually see any deviation 
in the borehole.  
 
The Deployment Details window shows further information on the deployment and contains controls to turn the 
deployments on and off in the 3D View window (see section 7.3). 
 

C-ALS and VS+ models 
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5.1.5 Station graphics 

Station coordinates are entered in the Station Details window. In the 3D View, the location of these coordinates is 
marked by a station graphic. 

 For C-ALS operations, these coordinates represent the collar location – the point at which the deployment 
begins. By default, these are represented in the 3D View by concentric circles which expand as the 
deployment progresses. 

 For VS+ operations, the coordinates represent the surveyed prism position and, taking into account prism 
offsets, the instrument position. By default, this location is marked in the 3D View with a rectangular grid. 

The station graphic includes text identifiers, grid lines or concentric circles, and an X (green), Y (blue), Z (red) axis. 
 
The station graphic can be reconfigured or toggled on and off using options in Settings > Station tab (see section 
4.3.9). 

5.1.6 Bounding box 

A bounding box appears around the active scan or deployment. The bounding box shows the geographic limits of 
the data.  
 
Which dataset is ‘active’ at any given time is determined by: 

 The deployment or scan which is currently in progress. 

 Tapping on a dataset in the 3D View. 

 Selecting a dataset in the Project tab. 

5.1.7 Imported data 

Any pre-existing data imported into the project can be viewed alongside data generated by the scanners within a 
project. 
 
The Project tab contains controls to turn imported data on and off in the 3D View window (see section 7.11). 

The C-ALS with a trail of deployment data 
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5.2 3D View tabs 

 
Multiple 3D Views can be open but only one is ‘active’ and displayed in the 3D View window at any time. Each 3D 
View is contained within a tab which is arranged, by default, along the left-hand side of the screen. For example, 
you may wish to have one view set as a top down, orthographic view, and another a perspective view for free 
rotation. 
 
The active 3D View tab is identified by bold text. 
 
Tap the tab Delete 3D View button to delete a 3D View tab. 
 
Tap the Add 3D View button to add a new 3D View tab. 

  

3D View tabs 

3D View tab 

Delete 3D 
View button 

Active 3D 
View  

Add 3D 
View button 

3D View  
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5.3 3D View buttons 

Buttons along the bottom of the 3D View window provide options for viewing data. 
 

 

 

5.3.1 Vertical and horizontal compass 

The vertical compass and horizontal compass are side bars in the 3D View which can be give a live readout of the 
direction and inclination in which you are viewing the data. Tap Vertical and horizonal compass to open a dialog.  
 

 
Use the Vertical Compass and Horizontal Compass switches to turn on the side bars in the 3D View. If one of 
the compasses is switched on, the Vertical and horizonal compass button moves to the top right of the 3D View. 
 

 
The Vertical Compass and Horizontal Compass are only available when using the Perspective display option 
(see section 5.3.2). 

Vertical and 
Horizontal compass 

Resize View control 

Right-click 
function 

3D View buttons 

Vertical and horizonal compass dialog 

Vertical and horizontal compasses switched on 

Vertical and 
Horizontal 

compass button 

Vertical compass 

Horizontal 
compass 
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5.3.2 View control 

The View control provides pre-defined view of all data currently active in the 3D View. To zoom to pre-defined views 
of specific scans, deployments, or stations, use other zoom buttons in the Control tab or in the Project tab. 
 
Tap View to open the View dialog. 
 

 
A choice of Perspective or Orthographic view is available.  

 In Perspective view, the data can be freely rotated. Objects which are far away are smaller than those 
nearby. A perspective viewpoint gives more information about relative distances and is often easier to view 
as it is familiar from our real-life view of the world. 

 In Orthographic view, the data is viewed from a fixed perspective. All edges perpendicular to the view 
direction appear in proportion, at the same scale. Uniform perspective is very useful when analysing data 
to see the floor level or the shape of a void from fixed viewpoints. 

You cannot rotate data when Orthographic view is selected. The default rotating action will pan the data 
instead. 

 
When the Orthographic view is selected, gridlines are projected onto the 3D View. The Vertical Ruler and 
Horizontal Ruler are displayed along the side and top of the screen respectively.  
 
An Orthographic options button appears in the top left of the 3D View. Tap the Orthographic options 
button to open the Orthographic options dialog. 

 

View dialog 
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o Show Grid: toggles the background grid off and on. 

o Lock Grid: holds the grid squares constant as you zoom in and out of the 3D View. With Lock 
Grid switched off, the grid resizes depending on the zoom level.  

o Vertical Ruler: shows a bar along the side of the 3D View. This displays grid coordinates if you 
are viewing from the top of the data, or the height if you are using a side view. 

o Horizontal Ruler: shows a bar along the top of the 3D View which displays grid coordinates. 

The View dialog offers six pre-defined views. Tap a pre-defined view to all active data from this angle. If you are 
using Perspective view, you can immediately rotate the data from the selected, pre-defined view. 

5.3.3 Drag action 

Determines the effect of dragging your finger, stylus or mouse on the 3D View. 

 Orbit: rotates data in the 3D View. This is the default action when using Perspective view. 

 Pan: pans data in the 3D View. This is the default action when using Orthographic view. 

 Look: sets the centre of rotation to be your current viewpoint, so you can look around the scene from a 
fixed location. 

 Zoom: zooms in when you drag up the screen and zooms out when you drag down the screen. 

5.3.4 Resize 

If a C-ALS is connected to Carlson Scan, the Resize button is available. Tap Resize to swap the active 3D View 
with the video window in the Control tab (see section 11.2). This provides a larger format view of the borehole 
camera image. It is recommended that you use this window arrangement during a deployment. This helps to ensure 
that you are in the best position to see the entrance to the void and any obstructions in the hole during a deployment. 
 
When you tap Resize, the video controls also swap position so that they always remain under the video window.  
 
A Resize button is also present underneath the Video window in the Control tab (see section 11.2). 

Orthographic view options 

Orthographic 
options button 

Orthographic 
options dialog 

Vertical ruler 

Vertical ruler 
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5.4 Function tabs 

By default, on the right-hand side of the screen, are up to five function tabs which allow control of the scanner, 
provide data viewing and analysis tools, and enable management of the project. 
 

 
Tap the required tab to make it active. 
 
The active function tab is identified by bold text and a blue highlight. 
 
Tap the active function tab to retract it and switch the 3D View to a full screen display. 
 
The function tabs are each outlined in the following sections. 

 Menu tab: see section 6. 

 Project tab: see section 7. 

 Scan tab: see section 8. 

 Measure tab: see section 9. 

 Control tab: see section 10 for use with the VS+, and sections 11 and 12 for use with a C-ALS. 

Function tabs 

Function tabs 

Active function tab 
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6 Menu tab 

The Menu tab contains buttons which offer project level and software level functions. 
 

 

6.1 New 

Tap New to start a new Carlson Scan project. 
 
A message window opens: ‘Do you want to save changes? All unsaved edits will be lost’. 

 Tap Save to save all changes in your existing project and continue to create a new project. 

 Tap Discard to reject any changes in your existing project and continue to create a new project. 

 Tap Cancel to cancel the new project operation and remain in your current project. 

After tapping Save or Discard, the Project Details window opens. Enter the required details for your new project 
and tap Accept to create the project (see section 7.1). 
 
To connect to a scanner, open the Control tab and click Find Scanners (see section 10.1 for a VS+, and section 
11.1 for a C-ALS). 

6.2 Open 

6.2.1 Open Carlson Scan projects 

Tap Open to open an existing Carlson Scan project. An Open dialog appears.  
 
Select the appropriate project from the recent files list. Alternatively, tap Browse Files to open an Open File 

Menu tab 
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windows dialog. Browse to the project location and select the *.NDV file to open the project in Carlson Scan. 
 
On opening a project, you can reconnect to a scanner via the Find Scanner button on the Control tab (see section 
10.1 for a VS+ and section 11.1 for a C-ALS) or through the Project Details window (see section 7.1). 

6.3 Import 

6.3.1 Import existing survey data 

Tap Import to import other files into your active Carlson Scan project. These files may contain pre-existing data 
such as surveyed points, solids or linework. This data can be used as a backdrop to data collected with the C-ALS 
and VS+. 
 
Currently supported file types are: 

 E57: Lidar point cloud data 

 LAS: LAS scan data file 

 LAZ: LAZ compressed scan data file 

 DXF: Autodesk DXF 

 DXF: Deswick DXF 

 DWG: AutoCAD drawing file 

 DRL: Carlson borehole data format 

 XML: LandXML 

 OMF: Open Mining Format 

 NDV: Carlson Boretrak project. Merge data from an existing project with the data in your current project. 

 TIN: Carlson triangulation format 

 OBJ: Wavefront Object 

 PLY: Polygon library 

 STL: Stereolithography 

 DAE: Collada 

 CSV: Hole ASCII. Imports hole collar information in a user-defined ASCII format. 

 *.*: Hole ASCII. Import hole collar information in a user-defined ASCII format. 

 *.* Point ASCII. Import survey points in a user-defined ASCII format. 

6.4 Save 

Tap Save to save all changes in your existing Carlson Scan project. 
 
Note that a backup project is continually saved in the Backup sub-directory in the project folder (see section 3.5). 
 
If you have not yet manually saved a project, the project is automatically saved in the _Unsaved Projects folder 
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(see section 3.5). 

6.5 Save As 

Tap Save As to save the project under a different name or in a different location on your tablet. 

6.6 Export 

Tap Export to export data from the active project. A file dialog opens. Select the location where you wish to save 
the data, the file name and the file type. 
 
Tap Save. Depending on the file type selected, an appropriate export dialog opens. Confirm the specific data within 
the project that you wish to export and configure any export options as required. 
 
After accepting all settings, tap Export to generate the export. 

6.7 Browse 

Tap Browse to open Windows File Explorer at the location where the active project is stored (see section 4.3.6). 

6.8 Print 

Tap Print to print a screenshot of the current 3D View. 

6.9 Alignments 

Tap Alignments to open the Alignments window. All alignments in a project are listed and can be examined and 
edited (see section 7.1.5). 

6.10 Stations 

Tap Stations to open a list of all the Stations in the active project (see section 7.1.2). 

6.11 Project 

Tap Project to open the Project Details window. The Project Details window contains information about the 
project, holes, and deployments that have been carried out within the current project (see section 7.1). 

6.12 Reports 

Tap Reports to open the Generate Reports window. 

6.13 Light / Dark / Black 

Tap Dark / Light / Black to toggle between the three themes. During in-field operations, whether it be underground 
or in bright sunlight, one particular theme may give a clearer view of the screen. 
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You may also need to change the background colour to improve visibility in certain lighting conditions (see section 
4.3.7). 

6.14 Desktop 

Tap Desktop to switch to the Desktop display mode (see section 3.6). 

6.15 Settings 

Tap Settings to view or edit software configuration settings. The Settings window appears (see section 4.3). 

6.16 About 

Tap About to access help documentation and program information.  
 
The version number of the software is shown in the About screen and should be quoted during any support call 
with Carlson. 

6.17 Wi-Fi 

Tap the Wi-Fi button to manage Wi-Fi connections between the tablet and your scanner.  
 
The Managed Wi-Fi option in the Settings window > General tab (see section 4.3.1) determines whether the Wi-
Fi is managed though Carlson Scan’s own Wi-Fi manager or through the standard Windows Wi-Fi manager. 

6.18 Exit 

Tap Exit to exit Carlson Scan. 
 
A message window opens: ‘Do you want to save changes? All unsaved edits will be lost’. 

 Tap Save to save all changes in your existing project and exit Carlson Scan. 

 Tap Discard to reject any changes in your existing project and exit Carlson Scan. 

 Tap Cancel to cancel the new project operation and remain in your current project. 
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7 Project tab 

The Project tab contains a record of all data collected or imported within the active Carlson Scan project. 
 

 
 
The list of elements in the Project tab expand indefinitely as more stations are added, scans are recorded, and 
data imported.  
 
Each element in the Project tab can be selected and acted upon using buttons which appear directly underneath 
the element.  
 

 
The buttons which appear are: 

 Details: opens a relevant window or tab, which shows information about the selected element and, where 
appropriate, offers functionality to configure or analyse the element. 

 Visible / invisible: toggles the selected element, and all elements nested beneath it in the Project tab, on 
and off in the 3D View. 

 Zoom: zooms in to the extents of the selected element, and all elements nested beneath it in the Project 
tab. Use the drop-down list to select a pre-set view. 

Project tabs for a VS+ project (left) and C-ALS project (right) 

Details, Visible/Invisible, Zoom and Export buttons 
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 Export: exports the selected element and, by default, all elements nested beneath it in the Project tab.  
Individual elements can be switched on or off during the export process. 

The elements in the Project tab are slightly different depending on whether you are using a C-ALS or VS+. 
 
Each element in the Project tab has a context menu, accessed by right-clicking the element. 
 

 
The list of items that may appear in the Project tab are listed below. 

7.1 Project 

At the top of the Project tab is the Project element.  
 

 
Tap the Project element to open the Project Details window. 

Project element 

Project 
element 

Project 
Details button 

Project tab context menu 
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The Project Details window contains six tabs. 

7.1.1 Project tab 

 Directory: displays the current location of the project. If required, edit the directory path in the text entry 
box, or tap the Browse button to the right to select a different address in which to save the project.  

 Project Name: displays the name of the project. If required, edit the project name in the text entry box. The 
project name will also be the name of the *.NDV project file and the project directory. 

 Surveyor: enter the name of the surveyor responsible for the project. 

 Notes: enter any project notes.  

7.1.2 Stations tab 

The Station tab provides tools for managing the stations in a project.  
 

Project window > Stations tab 

Project Details window 
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 For C-ALS operations the station defines starting point from which the scanner is deployed. Most commonly, 
this will be a collar location which marks the start of a deployment along a borehole.  

 For VS+ operations, the station defines the position of the surveyed prism which is mounted on the 
instrument. 

A list of all stations in the active project is displayed. The list shows the station name followed by the station 
coordinates and a Deploy button. 
 
To edit a station in the list, tap on the appropriate station to open the Station Details window (see section 7.2).  
 
To start a survey from a specific station, tap the Deploy button next to the appropriate station.  
 
In the 3D View, the location of these coordinates is marked by a station graphic. 
 
To add a new station to the project, tap the Add New button. The Station Details window appears (see section 
7.2). 
 
Tap Import to add holes to the project from a text file. The text file may contain hole name, row name, coordinates, 
and design information. Select a file and the Station ASCII Import Properties window opens. Define the columns 
in the file and tap Import. The stations are added to the list in the Project window > Station tab. 

7.1.3 Deployments tab 

The Deployments tab lists the C-ALS deployments which have been carried out in the active project. Deployments 
are only relevant to C-ALS operations. No deployments are listed if the project is used solely for VS+ operations. 
 

 
A list of all deployments in the active project is displayed. Each row in the list of deployments displays the Station 
from which the deployment was made, the Name of the deployment and the coordinates of the end of the 
deployment. 
 
To view details of a deployment in the list, tap on the appropriate deployment to open the Deployment Details 
window (see section 7.3). 
 
In the 3D View, the deployment is marked by a deployment graphic (see section 7.3.1). 
  

Project window > Deployments tab 
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7.1.4 Images tab 

The Images tab displays the images and videos which have been captured by the C-ALS camera during a project. 
 

 
Click on an entry in the list to view and export the snapshots and videos. 

7.1.5 Alignment tab 

The Alignment tab lists all the C-ALS alignments which have taken place during a project. 
 

 
An Alignment marks an alignment event carried out during field operations. 
 
The list shows the Name of the alignment, followed by the Heading that has been manually input or computed. 
 
To edit an alignment in the list, tap on the appropriate alignment to open the Alignment Details window (see section 
11.5.1). Edit the details as required. 
 
Note that if the heading of an alignment is edited, all data collected using the selected alignment will be affected by 
this edit. Each deployment will rotate around its collar position by the number of degrees by which the heading has 
changed. 
  

Project window > Images tab 

Project window > Alignments tab 
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7.1.6 Layer tab 

The Layers tab displays the layers into which the data in the 3D View is divided. 
 

 
The Layers in the list group together different categories of items in the project. For example, all deployments which 
followed a specific alignment, all text or all planned holes. These are listed in the Name column. 
 
Tick or untick the Visible checkbox to make the selected layers visible or invisible in the 3D View. 
 
Select a colouring option from the Display Settings drop down list. This selection overrides any colour settings for 
individual entities within the layer.  
 
Restore colour settings for individual entities within a layer by selecting the blank entry from the Display Settings. 
drop down list. 

7.2 Station 

Each Station in a project has its own element in the Project tab. There may be multiple Stations in a Project and 
they may be setup in advance of field operations. 
 
The Station may have Deployment (C-ALS only) and Scan elements nested beneath it.  

 The Station Visible / invisible button toggles all these elements on and off in the 3D View  

 The Station Zoom button positions the extents of all these elements within the 3D View.  

 The Station Export button exports data from all these elements. 

Project window > Layer tab 
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7.2.1 Station Details 

Tap the Station Details button to open the Station Details window. Depending on whether a C-ALS or a VS+ has 
been run from the selected station, the Station tab appears slightly differently.  
 

7.2.2 Station Setup tab – C-ALS 

The Station element represents fixed, starting coordinates for a survey. For C-ALS operations the station defines 
the starting point from which the scanner is deployed. Most commonly, this will be a collar location which marks the 
start of a deployment along a borehole. 
  

 
The Station Name text entry field displays the name of the station. Edit the name as required. 
 
The Survey Point frame displays the coordinates of the collar or start of the deployment. Edit the coordinates as 
required. 
 
The Planned Deployment frame enables the setup of ‘planned’ or ‘design’ hole properties. A deployment carried 
out with a C-ALS can be compared with the planned hole to establish the measured deviation along the length of 
the surveyed hole. 
 
One Planned Deployment can be set up for each Station in a project. 
 
The Planned Deployment can be set up using manually entered angles, or by entering coordinates for the end of 
the hole. Use the radio buttons to select between these options. 

 None: no Planned Hole is attached to the selected Hole. 

 Angles: enter a Depth, a Heading angle, and an Incline angle to establish the Planned Hole. 

 Target: enter the X,Y,Z coordinates of the end of the hole to establish the Planned Hole. The Depth is 
adjusted automatically. 

To use the same Planned Deployment values for holes which are created subsequently within the active project, 
tap Default. If a new hole is created, these planned hole values are applied when the Angles or Target radio 
buttons are selected. 
 

Station window > Collar Setup tab - C-ALS operations 
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To apply the same planned hole values to all holes which already exist in the active project, tap Set for All. 

7.2.3 Station Setup tab – VS+ 

The Station element represents fixed, starting coordinates for a survey. For VS+ operations, the station defines the 
position of the surveyed prism position and, after taking into account the prism offsets and survey orientation, the 
position of the ‘scan origin’ which is at the centre of the trunnion axis of the VS+. 
 

 
The Station Name text entry field displays the name of the station. Edit the name as required. 
 
The Prism Position frame assists positioning of the VS+ when survey observations are being taken to the supplied 
360° prism mounted on the VS+. There are two M6 × 1 threads on the horizontal housing of the VS+ into which the 
prism can be secured. Select either the Front or Rear position as required. Select None if you are not using a 
prism. 

Station window > Station tab – VS+ operations 
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The Prism position frame displays the coordinates of the surveyed prism. Edit the coordinates as required. 
 
The Azimuth offset frame gives a choice for entering a heading for the VS+ deployment. This is usually the azimuth 
of the boom: from the back end of the boom towards the VS+. 

 None: by default, the station has no user-defined azimuth. Leave the Reference Azimuth set to None and 
the survey is given an 0.00° azimuth by default. 

 Heading: select Heading and a text entry box and dial appear. Enter the surveyed heading or rotate the 
dial to re-orientate all data underneath the selected Station element. 

 Back-Point: if you have observed a secondary point to orientate the survey towards the Prism position 
(for example you may have observed to another prism on the back end of the boom) select Back-Point. 

Orientation Prism text entry boxes appear. Enter the coordinates of the secondary prism. A heading is 
computed from the Orientation Prism to the Prism position. 

 2-Point azimuth: if you have established an azimuth with reference to two points separate from the Prism 
position, select 2-Point azimuth. Front location and Orientation Prism text entry boxes appear.  

Enter the coordinates of the rear position as the Orientation Prism. Enter the coordinates of the front 
position as the Front location. The azimuth is computed from the Orientation Prism to the Front location. 

In this case, the main Prism Position is independent of the computed azimuth. 

 Relative: if you have multiple surveyed stations in your Carlson Scan project, you can visually align the 
VS+ between two of these stations. Select existing stations in the From and To drop down lists. A heading 
is computed between the two. 

When a scan is started from a station, the scan origin is derived by combining the Prism Mount selection, the 
Prism Position, the Reference Azimuth, and the inclination and roll values of the VS+. 
 
The scan origin or ‘Head location’ can be seen in the Scan Information window (see section 8.1.1). 

VS+ prism mounting locations - front (top) and rear (bottom) 
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Once the scan origin has been established, it only changes if you edit the Prism Mount, Prism Position or the 
Reference Azimuth.  
 
You should create a new station whenever the VS+ is physically moved. 
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7.2.4 Deployments tab 

The Deployments tab lists the C-ALS deployments which have been carried out from the selected station. 
Deployments are only relevant to C-ALS operations. No deployments are listed if the station has been used for 
VS+ operations. 
 

 
To view details of a deployment in the list, tap on the appropriate deployment to open the Deployment Details 
window (see section 7.3). 
 
Each row in the list of deployments displays the Name of the deployment, the coordinates of the end of the 
deployment and a Deploy button. 
 
To start a survey from the end of a specific deployment, tap the Deploy button next to the appropriate station. You 
may use this option if, for example, the scanner is still positioned in the void, at the end of a deployment but the 
operation was interrupted due to power failure. Alternatively, if you return to the site of a previous deployment, but 
do not wish to replicate the whole series of Boretrak readings, you can simply deploy down to the same position 
and then commence operations from the bottom of the hole. 
 
To start a new deployment from the same station, tap Add Deployment. A new deployment is added to the list of 
deployments. Tap the Deploy button next to the new deployment and then tap Accept. The C-ALS is ready to start 
a new deployment from the same station. 
 
In the 3D View, the location of the deployment is marked by a deployment graphic (see section 7.3) 

7.3 Deployment 

Each Deployment in a project has its own element in the Project tab. There may be multiple deployments from 
underneath a single Station. Deployments only relate to C-ALS operations. There are no Deployment elements 
created during VS+ operations. 
 
The Deployment may have Boretrak and Scan elements nested beneath it.  

 The Deployment Visible / invisible button toggles all these elements on and off in the 3D View  

 The Deployment Zoom button positions the extents of all these elements within the 3D View.  

 The Deployment Export button exports data from all these elements. 

Station window > Deployments tab 
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7.3.1 Deployment Details 

Tap the Deployment Details button to open the Deployment Details window.  
 

 
The Deployment tab > Results tab displays the sequence of Boretrak readings in tabular and graphical form.  
 
In the table, the top row represents the collar coordinate, and each subsequent row in the table is a Boretrak reading 
recorded during the deployment. Columns in the table display: 

 Az: the azimuth of the C-ALS at each reading. 

 Inc: the inclination of the C-ALS at each reading. 

 Length: the depth of the C-ALS at each reading. 

 Dev: The distance the surveyed hole has deviated from the planned holed (if a planned deployment is 
activated). 

 Dev%: The percent of hole length by which the surveyed hole has deviated from the planned hole (if a 
planned deployment is activated). 

 Time: the time at which the reading was taken. 

 E, N, Elevation: the coordinates of the C-ALS at each reading (the reference point is inside the probe at 
the vertical pivot point). 

The graphics show the deployment trail (in white) and the individual readings (displayed as dots).  
 
There are three tabbed views: 

 Plan view: displays a plan view ‘bullseye display’  

Deployment details window 
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 Front view (tabbed view to the right of the deployment table). With Heading: Hole Azimuth selected, the 
Front View displays a perspective along the heading of the deployment – ie the deployment hole is heading 
directly into the screen. With Heading: North/East selected, the view is looking North.  

 Side view (tabbed view to the right of the deployment table). Shows a view perpendicular to that of the 
Front View. 

The Deployment tab > Editor tab provides tools to adjust the Deployment and the Planned Deployment. 
 

 
The Segments frame provides controls which allow editing of the Deployment. Use these controls with caution. 

 Segment Length: edit the deployment interval that was used for the deployment. 

 Final Offset: edit the offset that was entered after the last reading taken during the deployment. 

The Visuals tab provides options for visualising the Boretrak deployment in the 3D View. 

  
Select a colour theme for the Boretrak data from the drop-down list, or a solid colour from the Colour button to the 

Deployment window > Editor tab 

Deployment window > Visuals tab 
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right. 
 
Options for visualising the Boretrak data are: 

 Hidden: turns off the Boretrak data in the 3D View. 

 Model: displays the Boretrak data as modelled Boretrak rods. 

 Polyline: displays the Boretrak data as a simple polyline. 

 Tube: displays the Boretrak data as a tube. The diameter of the tube can be entered into the Diameter text 
entry box, if you wish to represent the true borehole size. 

7.4 Boretrak 

The Boretrak element relates solely to the Boretrak trail that is created during a deployment. There are no other 
elements nested underneath the Boretrak element. 

 The Boretrak Visible / invisible button toggles the Boretrak data on and off in the 3D View  

 The Boretrak Zoom button positions the extents of the Boretrak data within the 3D View.  

 The Boretrak Export button exports the Boretrak data. 

7.4.1 Boretrak Details 

Tap the Boretrak Details button to open the Boretrak Details window. The Deployment tab is displayed, and the 
Results tab is displayed underneath. 
 
The Deployment tab > Results tab displays the sequence of Boretrak readings in tabular and graphical form. 
 
The display and other tabs are identical to the Deployment Details window (see section 7.3.1). 

7.5 Scan 

Each scan carried out within a project generates a Scan element in the Project tab.  
 
Each Scan element has a Mesh and Points element nested underneath it. 

 The Scan Visible / invisible button toggles all these elements on and off in the 3D View  

 The Scan Zoom button positions the extents of all these elements within the 3D View.  

 The Scan Export button exports data from all these elements. 

Click on any scan in the Project tab and the appropriate Scan tab becomes available (see section 8).  

7.5.1 Scan Information 

Tap the Details button to open the Scan Information window.  
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The Scan Information window contains information on the scan and options to examine and refine the results. The 
information is mainly available for troubleshooting purposes and should only be used by advanced users, or in 
conjunction with Carlson support.  
 
See section 8.1.1 for further details. 

7.6 Mesh  

A Mesh element is nested underneath every Scan element.  

 The Mesh Visible / invisible button toggles the Mesh on and off in the 3D View. The Mesh is invisible by 
default. 

 The Mesh Zoom button positions the extents of the Mesh within the 3D View. 

 The Mesh Export button exports the Mesh. 

7.7 Points 

A Points element is nested underneath every Scan element.  

 The Points Visible / invisible button toggles the Points on and off in the 3D View. The Points are visible 
by default. 

 The Points Zoom button positions the extents of the Points within the 3D View.  

 The Points Export button exports the Points. 

Scan Details window 
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7.8 Circle Scan 

A Circle Scan is a limited, single sweep scan carried out by a C-ALS (see section 11.7.4). There are no Circle 
Scan elements created during VS+ operations. 
 
Each Circle Scan element has a Mesh and Points element nested underneath it. 

 The Circle Scan Visible / invisible button toggles the Circle Scan on and off in the 3D View  

 The Circle Scan Zoom button positions the extents of the Circle Scan within the 3D View.  

 The Circle Scan Export button exports data from all these elements. 

7.8.1 Circle Scan Details 

Tap the Circle Scan Details button to open a Properties window which lists details of the Circle Scan, including 
the nearest and furthest points recorded during the scan. 

7.9 Mesh (circle scan) 

A Mesh element is nested underneath every Scan element. For a Circle Scan, the Mesh is a simple polyline which 
joins all points collected during the scan. The polyline is coloured according to the distance from the scanner: red 
is the closest and blue is the furthest. 

 The Mesh Visible / invisible button toggles the Mesh on and off in the 3D View. The Mesh is visible by 
default. 

 The Mesh Zoom button positions the extents of the Mesh within the 3D View.  

 The Mesh Export button exports the Mesh. 

7.9.1 Mesh Details 

Tap the Mesh Details button to open a Properties window which lists details of the Circle Scan, including the 
nearest and furthest points recorded during the scan. 

7.10 Points (circle scan) 

A Points element is nested underneath every Scan element. For a Circle Scan, the Points are coloured according 
to the distance from the scanner: red is the closest and blue is the furthest. 

 The Points Visible / invisible button toggles the Points on and off in the 3D View. The Points are invisible 
by default. 

 The Points Zoom button positions the extents of the Points within the 3D View.  

 The Points Export button exports the Points. 

7.10.1 Points Details 

Tap the Points Details button to open a Properties window which lists details of the Circle Scan, including the 
nearest and furthest points recorded during the scan. 
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7.11 Imported data 

Datasets which have been imported into the Carlson Scan project are listed at the bottom of the Project tab. 

 The Imported data Visible / invisible button toggles the Imported data on and off in the 3D View. 

 The Imported data Zoom button positions the extents of the Imported data within the 3D View.  

 The Imported data Export button exports the Imported data. 



 

P a g e  | 60 

8 Scan tab  

The Scan tab contains controls to change the appearance of the active point cloud and the mesh. The tab itself is 
labelled according to the active scan. In the image below, the active scan is H-Scan 1, and so the tab is shown as 
the H-Scan 1 tab. 
 

 

8.1 Active scan 

The active scan is displayed at the top of the Scan tab.  
 

 
The tools in the Scan tab only act on the active scan. 
 
Which dataset is ‘active’ at any given time is determined by: 

 The deployment or scan which is currently in progress. 

 Tapping on a dataset in the 3D View. 

Scan tab 

Active scan, Scan information button and Zoom button 
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 Selecting a dataset in the Project tab. 

Use the Active scan text box to edit the name of the scan, if required. 

8.1.1 Scan information 

To the right of the Active scan text box is the Scan information button. Tap the Scan information button to access 
more technical information on the positioning of the scan data, and statistics relating to the finished scan. 
 
The Scan tab displays information relating to the positioning of the C-ALS or VS+ during the scan. 
 

 

 Details: displays the scan name, selected scan pattern, the starting time of the scan and the duration of 
the scan. 

 Corrections / Drift / Calibration: the amount of correction that was applied to the orientation of the scanner 
during the active scan. This applies primarily to C-ALS ‘cable-only’ deployments where the scanner may 
have rotated, or the gyro drifted, during the course of the scan. These values are editable but extreme 
caution should be taken before any edits are carried out. 

 Scan Orientation: displays the pitch, roll and azimuth of the scanner when the scan was started. These 
values are derived from the onboard accelerometers and from surveyed azimuth information from the gyro 
or information entered into the Station window. These values are editable but extreme caution should be 
taken before any edits are carried out. 

 Head location: displays the ‘scan origin’ for the selected scan. This is the position to which all raw scan 
data is derived. For both the VS+ and the C-ALS, this point is at the centre of the instrument’s vertical pivot. 
This value will be correct if the deployment of the VS+ or C-ALS probe has been carried out correctly. 
However, in some specific cases you may wish to fine-tune this position to fit in with other data surveyed to 
a higher accuracy. Caution should be taken before any edits are carried out. 

Scan information window > Scan tab 
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The Properties tab displays statistics relating to the finished scan. 
 
Information includes: 

 Scan date 

 Scan pattern 

 Scan increment 

 Number of points captured 

 Volume computed 

 

 
The information listed may be useful during troubleshooting or support enquiries. 

8.1.2 Zoom to scan 

To the right of the Scan information button is the Zoom to scan button. 
 
The Zoom to scan button positions the extents of the scan within the 3D View. Use the drop-down list to select a 
pre-set view. 

8.2 Visualisation tools 

The visualisation tools control the appearance of the data collected in the active scan. 

Scan information window > Properties tab 
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 Select a Colour Scheme from the drop-down list to change the value which is used to determine the 
colouring of the scan. Options include: 

o Solid colour: select a single colour for the scan. 

o Intensity: scan is coloured according to the signal strength recorded for each data point. 

o Distance: scan is coloured according to the distance from the scanner. 

o Elevation: scan is coloured according to its relative height. 

 Use the Thickness slider to change the size of the points and the wireframe outline. 

 The Min, Mid and Max colour choices determine the colour range used to display the selected Colour 
Scheme. The Max, Mid and Min values will refer to different qualities depending on the colour scheme 
selected. 

8.3 Scan data 

The Scan data panel gives live information about the active scan. 
 

 

 Vertices: The number of computed data points used to create the mesh. 

 Volume: the computed volume inside the mesh. The volume is calculated in real time. An asterisk after the 
value indicates that the scan, or the computation, is ongoing. If no volume is shown, tap the Fill Holes 
button to ensure that the mesh is closed and that a volume can thus be calculated (see section 8.4). An 
asterisk after the value indicates that the scan, or the computation, is ongoing. 

Visualisation tools 

Scan tab live data 
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 Area: the footprint of the volume. An asterisk after the value indicates that the scan, or the computation, is 
ongoing. 

 Created: the time and date that the data was collected. 

8.4 Mesh tools 

The mesh tools offer functionality related to the properties of the scan and the appearance and construction of the 
surface model. Some of the mesh tools are only activated if the Mesh switch is toggled on in the Control tab (for 
live scans) or in the Project tab. 
 

 

8.4.1 Visibility 

Toggles the active scan on and off in the 3D View.  
 
Tap the Visibility drop-down menu to differentiate between turning the points and the mesh on and off in the 3D 
View. 
 

Mesh tools 
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 Tap the Points switch to toggle the points on and off in the 3D View. 

 

 Tap the Mesh switch to toggle the real-time mesh on and off in the 3D View.  

 

 
If the Mesh switch is on, more mesh tools are activated. 

Points visible 

Mesh visible (as a wireframe) 
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8.4.2 Gridlines 

Tap Gridlines to toggle gridlines on and off. Gridlines are projected onto the model to help you judge scale and 
gradient. 
 

 
A Gridlines window opens. 
 

 
Toggle and adjust the options as required. 

 Use the Thickness slider to adjust the weight of the gridlines in the 3D View. 

 X-cross section: enter the required spacing between gridlines. 

 Y-cross section: enter the required spacing between gridlines. 

 Contours: enter the required spacing between contours. 

 

Gridlines on (Two-sided off) 
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To save the generated linework, tap Generate linework. An entry containing the linework is created in the Project 
tab. 

8.4.3 Export 

Tap to export data from the active scan. A file dialog opens. Select the location where you wish to save the data, 
the file name and the file type. Tap Save.  

Depending on the file type selected, an export dialog opens. Confirm the data you wish to export and configure any 
export options before accepting all settings and generating the export. 

8.4.4 Smooth 

Provides options to smooth the mesh created. You may wish to leave these settings untouched and to use the 
automatically generated surface. However, the tools are available if you wish to optimise a specific scan surface. 
 

 

 Lighting: tap the Smooth Lighting switch to adjust how the solid model is lighted. When the Smooth 
Lighting switch is on, tap Max Smooth Angle to adjust the lighting angle. 

 Mesh: select Cotangent or Laplacian surfacing routines from the Mesh drop down list. The Cotangent 
option is better at preserving artefacts in a scan, but consequently will not smooth as well as the Laplacian 
routine. 

 Retain size: tap the Retain Size switch to toggle the Retain Size option on and off. If Retain Size is on 
and changes are made to the smoothing, the volume of the surface is forced to stay constant and the level 
of smoothing is restricted.  

 Smoothing level: select a level of smoothing from the list, from No Smoothing to Max Smoothing. No 
Smoothing is the routine which is most faithful to the collected points. The level of smoothing should 
correspond to the density of the active scan: the denser the scan, the higher the level of smoothing which 
can be used. 

8.4.5 Wireframe 

Toggle the Wireframe switch to view the mesh as a wireframe model or as a smoothed surface model. 

Smoothing options 
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8.4.6 Fill Holes 

In order for the volume of a scanned void to be computed, the surface model must be completely closed, without 
any holes. If no volume result is shown in the live data (see section 8.2), tap the Fill Holes button to ensure that the 
mesh is closed and that a volume can thus be calculated. 

Smoothed surface model 
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9 Measurement tab 

The Measurement tab provides tools for taking measurements from data within the active project. 
 

 
The measurement tools can be used with any data in the 3D View, including points, meshes and linework. 

9.1 Group name 

Name a group of measurements. If you save measurements, they are listed in the Project tab under this name. If 
you export measurements, the export file is named using the Group Name. 

9.2 Measurements 

Select the type of measurement you wish to carry out. 

9.2.1 Location 

Tap Location to investigate the coordinates of individual entities in the 3D View. 
 

Measurement tab 
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Tap on any entity in the 3D View to generate the coordinates of the selected point. The coordinates appear in the 
Measurement tab. 
 
Tap Finish to end the measurement session. The collected locations are added to the Project tab. 
 
Tap Clear to cancel the collected locations. 
 
Tap Export to export the collected locations in a user-defined file format. 

9.2.2 Distance 

Tap Distance to measure the distance between two items in the 3D View. 
 
Tap on any entity in the 3D View to start the distance measurement. Tap on a second point to complete the 
measurement. A table in the Measurements tab displays for each distance: 

 Slope distance 

 Horizontal distance 

 Vertical distance 

 Inclination 

Tap Finish to end the measurement session. The collected measurements are added to the Project tab. 
 
Tap Clear to cancel the collected locations. 
 
Tap Export to export the collected locations in a user-defined file format. 

Taking Locations 
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9.2.3 Angle 

Tap Angle to measure the distances and direction between items in the 3D View. 
 
Tap on any entity in the 3D View to start the angle measurement. After clicking on a second entity, a dynamic angle 
readout appears showing the angle between the line which has been created and the cursor. 
 
Tap Finish to end the measurement session. The collected measurements are added to the Project tab. 
 
Tap Clear to cancel the collected locations. 
 
Tap Export to export the collected locations in a user-defined file format. 
 

9.2.4 Cross Section 

Tap Cross Section to generate a series of cross sections along a user-defined centre line. 
 
A mesh must be visible in the 3D View for the cross sections to be generated.  
 
Create a centre line by clicking on two points. Hit Enter to accept the centre line. A series of cross sections is created 
perpendicular to the centre line. 
 
The Cross Sections are added to the Project tab. 

 
Tap Finish to end the measurement session. The cross sections are added to the Project tab. 
 
Tap Clear to cancel the generated cross sections. 
 
Tap Export to export the cross sections in a user-defined file format. 

  

Cross sections in the 3D View and in the Project tab 
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9.3 Snap settings 

After a measurement function is selected, the cursor in the 3D View changes appearance to a grey dot surrounded 
by a blue circle. 
 

 
The measurement tool attempts to ‘snap to’ items in the 3D View that are within the blue circle. The items that 
measurement tool searches for within the blue circle for are determined by the Snap settings. Turn the snap 
switches on or off depending on which items you wish to measure.  
 
For example, if you only wish to measure between single data points, turn off all switches except Points. In this 
case, the measurement tool only snaps to individual data points within the blue circle. It will ignore all other items 
such as edges and centre points of solid shapes. 
 
As the cursor snaps to items in the 3D View, it changes appearance again depending on which item it has snapped 
to. For example, if it has snapped to a single data point, it changes to a green circle. 
 

 
Cursor snapped to a single data point 

Cursor in measurement mode 
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10 Control Tab – VS+ 

The Control tab provides direct control of the connected scanner. The Control tab is configured according to 
whether a C-ALS or VS+ is connected to Carlson Scan. This section outlines the Control tab functions and layout 
when a VS+ is connected. 

10.1 Connection to a VS+ 

10.1.1 Autodetect routine 

Carlson Scan has an autodetect routine to establish if there are any scanners connected to the tablet. Once the 
routine is initiated, any scanner which is powered on and correctly interfaced with the tablet is detected. Carlson 
Scan first identifies that a VS+ is connected (or a C-ALS if that is the scanner you are using – see section 11.1) and 
then establishes the serial number, firmware and internal sensors within the instrument. 
 
The autodetect routine can be started automatically by tapping the New button from the Touch mode Home screen. 
This is the quickest way to get started with scanner operations.  
 
Alternatively, tap the Find Scanners button in the Control tab to initiate the autodetect routine.  
 

 
The Find Scanners button is present on the Control tab in the following situations: 

 If you have opened Carlson Scan in Touch mode, from the Home screen tap New to start a new project. 
Enter any required details in the Project Details window and tap Accept. 

 If you have opened an existing project and are viewing data without a connection to a scanner. 

 If you are in an existing project and have lost connection with a scanner or have tapped the Disconnect 
Device button. 

Once the autodetect routine has been initiated, the Find Scanners button changes to a Stop Searching button. 
Tap the Stop Searching button to end the autodetect routine. 

Find Scanners button and Wi-Fi button 
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While the autodetect routine continues, Carlson Scan searches through all available COM ports and IP connections 
for scanners connected to the tablet. 

10.1.2 Wi-Fi connection  

Prior to initiating the autodetect routine, you may have used the standard Windows tools to connect to a Wi-Fi device 
such as the VS+. This allows the autodetect routine to find the scanner. 
 
However, you can also connect to a Wi-Fi device from within Carlson Scan. Prior to using the Find Scanners 
button, tap the Wi-Fi button. 
 
Depending on whether the Managed Wi-Fi switch in the Settings window is toggled ON or OFF (see section 4.3.1), 
either the Windows Wi-Fi manager or the Carlson Scan Wi-Fi Manager window appears. In the case below, the 
Managed Wi-Fi is toggled ON, so the Carlson Scan Wi-Fi Manager appears. 
 

 
All Wi-Fi networks are displayed in a list. 
 
Tap Refresh to refresh the list of Wi-Fi networks.  
 
When you see your scanner listed in the Wi-Fi Manager, tap the appropriate entry in the list, then tap Connect. 
Carlson Scan runs the autodetect routine to identify a scanner on the selected Wi-Fi network. 

Stop Searching button and Wi-Fi button 

Carlson Scan Wi-Fi Manager 
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10.1.3 Connected 

On detection of a scanner, Carlson Scan runs through checks to establish that comms with the scanner are sound 
and to read information from the scanner. 
 
With all checks complete, a graphic of the VS+ appears in the 3D View.  
 
The Control tab is active, displaying VS+-specific controls. These controls are outlined below. 
 

 

10.2 Live data 

 
The live data text displays real-time information on the VS+. 

 Incline: the current inclination of the VS+ with respect to gravity. 0° is vertically down. 

 HDG: the current heading of the VS+, as manually entered in the Station Details window (see section 
7.2.3). 

 Red Dot: Tap the Red Dot switch to toggle the VS+’s red dot pointer on and off. 

Control tab active - connected to a VS+ 

VS+ live data 



 

P a g e  | 76 

 Voltage: The voltage level received from the VS+ and from the tablet running Carlson Scan. Tap on the 
Voltage icon to view the current battery status. 

 

 

If you are connected via a VS+ a lithium-ion battery is being used to power the system. The Voltage display 
turns red if a voltage is returned below 11.5 V. A warning message appears the first time this occurs during 
a session connected to the VS+. If the voltage drops below 11.2 V, Carlson Scan software carries out a 
controlled shut-down of the current scan. In this case, the Carlson Scan project is automatically saved, 
along with any terminated scans.  

Note that the VS+ power button changes from constant illumination to flashing when the battery voltage 
drops below 13.6 V. The VS+ shuts down automatically when the internal battery voltage drops below 10.8 
V. 

The VS+ probe automatically powers itself down if the voltage falls to voltage of 10.5 V or below is returned. 

 Temp: the current temperature received from the VS+. Tap on the Temperature icon to view the current 
temperature status. 

 

 
The temperature limits of the VS+ are -10° C to +45° C. If the temperature of the probe approaches within 
5° of these limits, the temperature value will display in red. 

Battery status of the tablet and VS+ 

Temperature status of the VS+ 
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10.3 Active station controls 

 

 The active station is displayed in the Station drop-down list. 

Tap the Station drop-down list to see all stations in the active project. From the list, tap New Station to 
create a new VS+ station. The Station Details window appears from where you can configure the new 
station (see section 7.2.3). 

 Tap the Station Details button to open the Station Details window. Edit details of the active station 
including name, coordinates and view options. 

 Tap the Zoom button to zoom to a view of the active station and all data that has been collected from that 
station. Tap the Zoom drop-down list to access pre-defined views of the station. 

 Tap the Disconnect button to disconnect Carlson Scan from the connected VS+. A message box appears: 
‘Are you sure you want to disconnect? All commands will finish and the device will move to the stow 
position’.  

Tap Yes to continue. Carlson Scan disconnects from the VS+. The Find Scanners button is activated on 
the Control tab.  

Tap Cancel to remain connected to the scanner. 

10.4 VS+ scan configuration 

 
The scanning configuration tools offer functionality for configuring a scan. 

 Mode: determines the pattern of the scan. From the drop-down list, select from: 

o Horizontal: the scanner completes a series of horizontal scan sweeps, separated by a stepped 
vertical increment 

o Vertical: the scanner completes a series of vertical scan sweeps, separated by a stepped 
horizontal increment 

o Horiz+Vert: the scanner completes a horizontal scan followed by a vertical scan. Carlson Scan 
treats the two scans as a single element for the purposes of display, colouring, meshing and 
exporting. 

 Sweep: determines the size of the vertical increment (if a horizontal scan is selected) or horizontal 
increment (if a vertical scan is selected). The smaller the increment, the more scan sweeps the VS+ 

Station controls 

VS+ scan configuration 
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completes, the denser the resulting point cloud, and the longer the duration of the scan.  

From the Increment drop-down list, select the required increment. The entries in the drop-down list show 
the increment in degrees followed by (in brackets) the approximate time to run the scan.  
 
To enter a user-defined increment, select Custom from the drop-down list. The number pad opens. Enter 
your required increment and tap Accept. The smallest definable scan increment is 0.3 degrees.  
 
Note that due to the mechanics of the scanner, the actual increment and scan time may differ slightly from 
the selected values. 

 Speed: select Fast or Dense from the drop-down list, to determine the speed of the scan. For most 
operations, leave the speed set to Fast. Alternatively, select Dense and each scan will run approximately 
70% slower, with approximately 70% more points along each scan sweep. The Dense option is mainly 
intended for very large voids where the spacing between each point on a scan line can become very large 
on the most distance surfaces.  

Note that the Sweep control defines the density of scan sweeps whereas the Speed control defines the 
density of points along each scan sweep. 

 Last Hit: Tap the Last Hit switch to toggle Last Hit mode on and off. The Last Hit option can be used if 
there are particles between the instrument and the target which are partially blocking the path of the laser. 
The particles may be water vapour or dust in the air which may cause the laser pulse to reflect back to the 
instrument before it hits the intended target. Activating this mode will instruct the VS+ to attempt to ignore 
any interference from the particles in the air and instead to concentrate on returns from the true target.  

The Last Hit option should not be used to shoot to reflective targets, as incorrect results may be returned. 

 Scan Limits: Tap to set limits on the vertical or horizontal scan sweeps. 

 

 
In order to save time and to concentrate the scan in certain directions, the scan can be limited vertically (most 
appropriate for horizontal scans) or horizontally (for vertical scans). 
 

For a VS+, the default ‘full scan’ range values are: 

 Horizontal: -180° to 180°. 

 Vertical: 180° to 50°. 

Scan Limits window 
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10.5 Scan controls 

The scan controls enable scans to be started using the settings determined with the scan configuration tools. 
 

 

 Scan: With the scan configured, tap Scan to begin the scan. The Scan button is greyed out until the scan 
is complete or cancelled. 

 Pause: during a scan, tap Pause to interrupt a scan that is in progress. The VS+ completes the current 
scan sweep before pausing. 

While the scan is paused, tap Scan to continue the scan or tap Stop to abort the scan and park the VS+. 

 Stop: during a scan, or while a scan is paused, tap Stop to end the scan. The VS+ parks and Carlson 
Scan displays a summary of the completed scan. 

10.6 During a scan 

Once a scan has been started, no further user intervention is required. The VS+ will progress through the scan 
according to the configuration selected.  
 

 
During a scan, some controls are disabled and others change to become more relevant for the duration of the scan. 

Scan, Pause and Stop buttons 

During a VS+ scan 
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10.6.1 3D View 

While a scan is in progress, the graphical model of the scanner replicates the mechanical movement of the laser 
head. The laser is displayed as a red line while it is firing (although in reality the measuring laser is invisible).  
 

 
All points collected are displayed in real time in the 3D View. 
 
Set different views in the 3D View tabs to make it easy to switch between pre-defined views or between orthographic 
and perspective views. 
 
Standard controls can be used to pan, rotate and zoom the data for visual analysis during the scan (see section 
5.1). 
 
To display the 3D View in full screen mode, retract the Control tab or any other active function tab. 

10.6.2 Progress dial 

 
A live progress dial shows the scan progress including: 

 Approximate time remaining  

 Percentage of the scan completed 

 A blue progress bar around the dial 

VS+ laser during a scan 

Progress dial during a scan 
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When the Control tab is not active, the progress information is displayed in the status bar at the bottom of the 
screen. 

10.6.3 Visualisation tools 

The visualisation tools control the appearance of the data collected in the active scan. 
 

 

 Tap the Points switch to toggle the points on and off in the 3D View. 

 Tap the Mesh switch to toggle the real-time mesh on and off in the 3D View. 

 Select a colour scheme from the drop-down list to change the colouring of the scan. Options are: 

o Solid colour: select a single colour for the scan. 

o Intensity: scan is coloured according to the signal strength recorded for each data point. 

o Distance: scan is coloured according to the distance from the scanner. 

o Elevation: scan is coloured according to its relative height. 

Note you can open the Scan tab to further modify the view of the active scan and the real-time mesh (see section 
8). The datasets in the 3D View can also be toggled on and off in the Project tab (see section 7). 

10.6.4 Scan controls 

During a scan, the scan controls enable scans to be paused, restarted or stopped. 
 

 

 Pause: during a scan, tap Pause to interrupt a scan that is in progress. The VS+ completes the current 
scan sweep before pausing. 

While the scan is paused, tap Scan to continue the scan or tap Stop to abort the scan and park the VS+. 

 Stop: during a scan, or while a scan is paused, tap Stop to end the scan. The VS+ parks and Carlson 
Scan displays a summary of the completed scan.  

10.6.5 Scan completion 

When a scan has completed, or been cancelled, the VS+ laser head will park in its original position. 
 
A summary of the scan appears in a message box. 

Scan, Pause and Stop buttons 

Visualisation tools 
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You can conduct further scans from the same station if the VS+ has not physically moved. However, you must 
create a new station whenever the VS+ has been moved, as only one set of inclination and roll values apply to any 
given station. 

Scan summary 
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11 Control Tab – C-ALS deployment 

The Control tab provides direct control of the connected scanner. The Control tab is configured according to 
whether a C-ALS or VS+ is connected to Carlson Scan. This section outlines the Control tab functions and layout 
when a C-ALS is connected and a C-ALS deployment is being prepared, or is in progress.  
 
Tap the Scan button at the bottom of the Control tab (see section 11.7.7) and the Control tab will again change 
configuration (see section 12) so that it is appropriate for scanning operations. Tap Deployment to return to the 
Deployment controls. Switch between the Deployment controls and Scan controls as required for your project. 

11.1 Connection to a C-ALS 

11.1.1 Autodetect routine 

Carlson Scan has an autodetect routine to establish if there are any scanners connected to the tablet. Once the 
routine is initiated, any scanner which is powered on and correctly interfaced with the tablet is detected. Carlson 
Scan first identifies that a C-ALS is connected (or a VS+ if that is the scanner you are using – see section 10.1) and 
then establishes the serial number, firmware and internal sensors within the instrument. 
 
The autodetect routine can be started automatically by tapping the New button from the Touch mode Home screen. 
This is the quickest way to get started with scanner operations.  
 
Alternatively, tap the Find Scanners button in the Control tab to initiate the autodetect routine. 
 

 
The Find Scanners button is present on the Control tab in the following situations: 

 If you have opened Carlson Scan in Touch mode, from the Home screen tap New to start a new project. 
Enter any required details in the Project Details window and tap Accept. 

 If you have opened an existing project and are viewing data without a connection to a scanner. 

 If you are in an existing project and have lost connection with a scanner or have tapped the Disconnect 
Device button. 

Once the autodetect routine has been initiated, the Find Scanners button changes to a Stop Searching button. 
Tap the Stop Searching button to end the autodetect routine. 
 

Find Scanners button and Wi-Fi button 
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While the autodetect routine continues, Carlson Scan searches through all available COM ports and IP connections 
for scanners connected to the tablet. If you are using a C-ALS, then Carlson Scan checks for: 

 A C-ALS connected via an Ethernet cable 

 A C-ALS connected via a Wi-Fi link 

11.1.2 Wi-Fi connection  

Prior to initiating the autodetect routine, you may have used the standard Windows tools to connect to a Wi-Fi device 
such as the C-ALS surface unit. This allows the autodetect routine to find the scanner. 
 
However, you can also connect to a Wi-Fi device from within Carlson Scan. Prior to using the Find Scanners 
button, tap the Wi-Fi button. 
 
Depending on whether the Managed Wi-Fi switch in the Settings window is toggled ON or OFF (see section 4.3.1), 
either the Windows Wi-Fi manager or the Carlson Scan Wi-Fi Manager window appears. In the case below, the 
Managed Wi-Fi is toggled ON, so the Carlson Scan Wi-Fi Manager appears. 
 

 
All Wi-Fi networks are displayed in a list.  
 
Tap Refresh to refresh the list of Wi-Fi networks.  
 

Connecting to a C-ALS 

Carlson Scan Wi-Fi Manager 
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When you see the scanner to which you wish to connect listed in the Wi-Fi Manager, tap the appropriate entry, then 
tap Connect. Carlson Scan runs the autodetect routine to identify a scanner on the selected Wi-Fi network. 

11.1.3 Connected 

On detection of a scanner, Carlson Scan runs through checks to establish that comms with the scanner are sound 
and to read information from the scanner. 
 
With all checks complete, a graphic of the C-ALS appears in the 3D View.  
 
The Control tab is active, displaying C-ALS-specific controls. These controls are outlined below. 
 

 

Control tab active - connected to a C-ALS 
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11.2 Video 

 
The C-ALS video window displays a real-time video feed from the borehole camera in the C-ALS. It is usually 
essential to monitor the video during deployment.  
 
On connection with a C-ALS, Carlson Scan automatically displays the video feed. A ‘Connecting’ message appears 
in the video window until the connection to the video stream is ready. 
 

 
Once connected, the video stream is always visible during a deployment.  
 
In the event that Carlson Scan cannot recognise a video stream, a warning icon is displayed in the video window. 
 

 
In this case, tap the Reset button (see section 11.2.1). If this does not produce a video display, reboot the C-ALS 
surface unit. 

Connecting to the C-ALS video stream 

C-ALS video window 

Video stream not available 



 

P a g e  | 87 

11.2.1 Video Controls 

Tap on the video window to access video controls. 
 

 

 Reset: resets the video stream. Tap Reset if you are experiencing video issues. 

 Record snapshot: takes an image of the current borehole camera view. The image is saved as a *.jpg file 
and saved in the Screenshot folder of the project. 

 Lighting: controls the LEDs around the camera. By default, the LEDs are on during a deployment and off 
during a scan.  

 Record video: toggles video recording on and off. The video is recorded as an *.mp4 file. The video is 
saved in the Video folder of the project. The button colour indicates the current status of the recording. 

 

 Invert: inverts the shading in the video image. This can make some images easier to analyse. 

 Orientation: reorientates the camera image in real-time as the C-ALS head rotates. 

 Zoom in / zoom out: allows digital zooming in and out of the live camera image. 

 Resize: swaps the video window in the Control tab with the active 3D View. This allows a larger format 
view of the borehole camera image. By default, the camera view is swapped to the main 3D View during a 
deployment. This helps to ensure that you are in the best position to see the entrance to the void and any 
obstructions in the hole during a deployment. 

When you tap Resize, the video controls also swap position so that they remain under the video window at 
all times.  
 
A resize button is also present underneath the 3D View window (see section 5.3.4). 

11.3 Active station controls 

 

 The active station is displayed in the Station drop-down list.  

Tap the Station drop-down list to see all stations in the active project. From the list, tap New Station to 
create a new C-ALS station. The Station Details window appears from where you can configure the new 
station (see section 7.2.2). 

Active station controls 

Video controls 

Video recording OFF (left) and ON (right) 
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 Tap the Station Details button to open the Station Details window. Edit details of the active station 
including name, coordinates and view options (see section 7.2.2). 

 Once a deployment is in progress, the Finish deployment button is active. Tap the Finish deployment 
button if you wish to end the current deployment and retrieve the C-ALS probe.  

 Tap the Zoom button to zoom in to the active station. Tap the Zoom drop-down list to access pre-defined 
views of the scanner. 

 Tap the Disconnect button to disconnect Carlson Scan from the connected C-ALS. A message box 
appears: ‘Are you sure you want to disconnect? All commands will finish and the device will move to the 
stow position’. 

Tap Yes to continue. Carlson Scan disconnects from the C-ALS. The Find Scanners button is activated 
on the Control tab.  

Tap Cancel to remain connected to the scanner. 

11.4 Live data 

 

 
The live data text displays real-time information on the C-ALS. 

 Incline: the current inclination of the C-ALS with respect to gravity. 0° is vertically down. 

 HDG: the current heading of the C-ALS. The heading is taken directly from the gyro, with reference to the 
entered alignment heading. The figure refers to the direction that the nose of the C-ALS probe is pointing, 
as seen from a plan view. When the probe is pointing directly vertical down or up, the displayed HDG value 
may be seen to fluctuate rapidly as the direction is less distinct. This will not affect stability or accuracy of 
the end results. 

 Temp: the current temperature received from the C-ALS. If the Gyro deployment mode has been selected, 
the temperature is taken from the gyro’s own internal sensor.  

The temperature limits of the C-ALS are -10° C to +60° C. If the temperature of the probe approaches within 
5° of these limits, the temperature value will display in red. 

 Voltage: the voltage level received from the C-ALS surface unit. 

The Voltage display turns red if a voltage is returned below 11.0 V. A warning message, shown below, 
appears the first time this occurs during a session connected to the C-ALS. If the voltage falls below 10.7 
V, the software will carry out a controlled shut-down of the scan.  
 
The C-ALS probe automatically powers down if a voltage of 10.5 V or below is returned 

 Length: The distance that the C-ALS has been deployed from the collar during the active deployment. The 
Length is computed by the number of Segments recorded multiplied by the Increment used for each 
segment. 

Note that the counting of the segments is a purely manual exercise: if you mistakenly forget to take a reading 
or take multiple readings at any stage of the deployment, then the Length will be incorrect. 

 Segments: the total number of Boretrak readings taken, irrespective of the Increment set for each reading. 

C-ALS live data 
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11.5 Gyro control 

The gyro is used to monitor the changing heading of the C-ALS probe during the deployment. The gyro is integrated 
into an IMU (inertial measurement unit) which also includes accelerometers. The IMU ensures that the pitch, roll 
and yaw of the C-ALS probe can be tracked through all inclinations and headings. 
 
Since the gyro in the C-ALS probe is not a north-seeking gyro, an initial, starting heading must be entered. Once 
the probe has been calibrated in alignment along the entered heading, the gyro then tracks the heading as it 
changes during handling and deployment. 
 
The Gyro button in the Control tab interface contains live information about the status of the gyro. The various 
states that the button can display are: 

11.5.1 Unaligned 

When the C-ALS probe is first powered up and connected to Carlson Scan, the gyro will be unaligned. At this stage 
the Align Gyro button is red and reads Align Gyro. The gyro must be aligned before a deployment can commence. 
 

 
To name the alignment, enter a name in the Alignment ID text field. By default the name is Alignment hh:mm. 
 
The heading of the alignment jig can be entered in the Azimuth frame. Note that the different methods listed under 
Azimuth are determined by the configuration of settings in the Settings window > Stations tab (see section 4.3.9). 
Some methods may be disabled if they are considered redundant for your operations. 
 
The available methods are listed below. 

 None: a default value of 0.00 degrees is used for the heading. 

 Heading: If you have surveyed in the alignment jig and computed a heading, select Heading and enter the 
surveyed value. 

 Back Point: manually enter a ‘back point’ coordinate. A heading is computed from the back point to the 
hole collar.  

 Two Point: manually enter a back point and a front location. A heading is computed from the back point to 
the front location.  

 Relative: If you have lined up the alignment jig between two holes which have been defined in your project 
with known coordinates, select Relative. Select two hole collars from the To and From drop down lists. A 
heading is computed between the two locations. 

 Use Existing: select a previously used alignment from a drop down list. The heading is copied from the 
selected alignment. 

Tap Close to close the Alignment window. 

11.5.2 Aligning 

Whilst aligning, the Align Gyro button is yellow, with a green progress bar, and reads Aligning Gyro. 

Gyro - unaligned 
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During this stage, the probe must be absolutely stable and free from movement and vibration. The probe must also 
be positioned in a known heading. The alignment takes approximately five seconds. 

11.5.3 Verifying alignment 

Immediately after an alignment, Carlson Scan monitors the gyro drift to ensure that a clean alignment has occurred. 
Again, the Align Gyro button is yellow, with a green progress bar. It now reads: Verifying Alignment. 
 

 
The probe must remain static. The verification takes approximately five seconds. 

11.5.4 Aligned – deployment not started 

When an alignment is successfully completed, the Align Gyro button is green. A display of the time since the 
alignment is shown on the Align Gyro button. The deployment can proceed. 

 

 
The button to the right of the Align Gyro button opens the Alignment setup window. Edit the alignment as required. 
  

Gyro - aligning 

Gyro – aligned 

Gyro - verifying alignment 



 

P a g e  | 91 

11.5.5 Aligned – deployment started 

Once the first deployment reading has been taken, the Align Gyro button disappears and is replaced by an 
Alignment icon. 
 

 
Tap the Alignment icon to check the alignment. 
 
An Alignments Options dialog opens displaying the time since last alignment. 
 

 
Tap Verify to check how much the gyro has drifted since the last alignment. Place the probe back on the jig, in the 
same orientation. The jig must not have been moved since the last alignment. 
 
The current heading is compared to the user-defined alignment heading from the last alignment. 
 

 
  

Alignment icon 

Alignment Options 

Alignment drift check 
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11.5.6 Losing alignment 

If, during the survey, the probe is moved beyond the limitations of the gyro (i.e. a faster than the 400°/second 
maximum rotation rate) then an error message appears, and the Gyro button reverts to the Align Gyro state. 

 

 
Full details of the C-ALS operations and procedures are outlined in section 16. 

11.6 Joystick controls 

The joystick controls help the operator to use the C-ALS borehole camera to inspect a void. While the joystick 
controls are active, the camera image is shown in the main 3D View. 
 

 

11.6.1 Joystick 

Move the joystick to manipulate the C-ALS scan head and thus to change the camera view. The scan head moves 
at two speeds. Pull the joystick further from the central position to increase the speed. 

Gyro exceeded rotational speed limit 

C-ALS joystick controls 

Lighting 

Video 

Park 

Settings 

Snapshot 

Circle scan 

Head 
orientation 

Joystick 
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11.6.2 Head orientation 

While the joystick is in use, the displayed INC (inclination) and HDG (heading) show the orientation of the scan 
head as it is moved. 

11.6.3 Lighting 

Controls the brightness of the LEDs which surround the C-ALS borehole camera. A vertical slider bar appears.  
 
Drag the slider up to brighten the LEDs.  
 
Drag the slider down to dim and turn OFF the LEDs. 

11.6.4 Park 

Return the scan head to the default ‘parked’ position in line with the body of the C-ALS. 

11.6.5 Settings 

Open a Settings window to change the default operation of the joystick controls. 
 

 

11.6.6 Snapshot 

Takes an image of the current borehole camera view. The image is saved as a *.jpg file and saved in the Screenshot 
folder of the project. 

11.6.7 Circle scan 

Carries out a circle scan whilst retaining the current vertical angle of the scan head. This allows a 360° view around 
the probe with the borehole camera. 

Joystick Control settings 
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11.7 Deployment Controls 

During most deployments, the C-ALS is lowered or pushed along the borehole at fixed intervals. At each interval, 
the C-ALS is held steady while a Boretrak reading is taken.  

 

11.7.1 Length 

The Length display shows the distance the probe has been deployed from the collar during the active deployment. 
This value is computed from the number of readings taken, multiplied by the selected Interval. 
 
Note that the counting of the segments and the choice of Interval are purely manual. If you mistakenly forget to 
take a reading or take multiple readings at any stage of the deployment, then the Length will be incorrect. 

11.7.2 Segments 

Segments displays the total number of readings taken, irrespective of the Interval set for each reading. 

11.7.3 Interval 

Use the Interval drop-down to define the physical increment between each Boretrak reading. In the drop-down list 
are three options  

 1 m. 

 2 m: this is the default for the first reading taken in a deployment – i.e. it is expected that the probe and 
extension piece will both be deployed into the hole before the first reading is taken. 

 Custom: this activates the number-pad so that you can enter a user-defined distance. This is often required, 
particularly for a final Boretrak reading when adjusting the probe to be in the correct position to scan. 
Negative values can be entered if the probe is being pulled back to the collar between scans rather than 
being lowered away from the collar.  

The selected option can be changed at any point during the deployment. 

11.7.4 Circle scan 

Tap Circle scan to carry out a circle scan.  
 

C-ALS deployment controls 
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A circle scan involves the laser head rotating around the horizontal axis to produce a single, circular scan.  
 
A circle scan is particularly useful during a deployment to check whether the probe has been deployed far enough 
into a void. The results from the circle scan help to establish if there is enough space around the laser head for the 
C-ALS to conduct a full scan with the full range of vertical rotation. It is safer to use a circle scan to perform this 
check as the head will not move vertically and thus, even if the probe is still in the borehole and has not yet emerged 
into the void, it will not jam against the adjacent rock. 
 
When the circle scan is complete, a scan summary appears. The distances to the nearest and furthest points 
recorded are displayed. 
 

 

If any distance less than 25 cm is observed during the circle scan, a warning appears: ‘Warning: surfaces detected 
very close to the laser. The C-ALS scan head may be physically obstructed if you run a scan from the probe’s 
current location’.  

In this case, if practical, consider deploying the C-ALS further into the void and retrying the circle scan. However, 
always ensure that sufficient length of the probe/extension piece is left in the borehole to avoid the whole length of 
the C-ALS dropping into the void. If in doubt, retrieve the C-ALS. If the C-ALS is deployed further, take another 
Boretrak reading with the correct custom increment value. 

11.7.5 Take reading 

Tap Take Reading to take one Boretrak reading each time that the C-ALS reaches the pre-defined deployment 
interval.  
 
Only take a Boretrak reading when the sensors are steady, so allow a few seconds for the probe to stabilise after it 
is lowered.  
 
After each reading, the Segments display increases by one and the Length display increases by the value selected 
in Increments drop-down. 
 
Each Boretrak reading is also registered in the 3D View and as an additional entry in the Deployment window (see 
section 7.3). 
 
Take care to synchronise the physical deployment of the C-ALS probe with the recording of the related deployment 
increment in Carlson Scan. It is easy to lose concentration during an operation and to mistakenly miss a reading 
or to take an extra reading before the probe has moved to the next interval. 

11.7.6 Undo 

If you have mistakenly taken a Boretrak reading, tap Undo reading to clear the last reading from Carlson Scan.  
 
A warning message appears. Tap Accept to continue and deleted the last Boretrak reading. 

Circle scan summary 
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After removing a Boretrak reading, the Segments display and the Length display revert to their previous values. 

11.7.7 Switch to scan controls 

When a deployment is complete and the C-ALS probe is secured in position to carry out a scan, tap Scan. The 
deployment controls are replaced by scan controls (see section 12) 
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12 Control Tab – C-ALS scan 

The Control tab provides direct control of the connected scanner. The previous section outlined the controls used 
during a deployment. After completing a deployment, tap the Scan button. Tools related to scanning operations 
appear in the Control tab.  
 
Tap Deployment to return to the Deployment controls. Switch between the Deployment controls and Scan 
controls as required for your project. 

12.1 Scan Controls 

The scanning configuration tools offer functionality for configuring and initiating a scan. 
 

 

12.1.1 Mode 

The Mode selection determines the pattern of the scan. From the drop-down list, select from: 

o Horizontal: the scanner completes a series of horizontal scan sweeps, separated by a stepped 
vertical increment 

o Vertical: the scanner completes a series of vertical scan sweeps, separated by a stepped 
horizontal increment 

o Horiz + Vert: the scanner completes a horizontal scan followed by a vertical scan. Carlson Scan 
treats the two scans as a single element for the purposes of display, colouring, meshing and 
exporting. 

o Image only: a series of images are recorded across the full range of view of the camera. 

o Video scan: the scan head moves vertically by 90° and then rotates horizontally 360°. During these 
movements, a video is recorded, giving a view around the probe. No scan data is recorded. 

  

Scan controls 
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12.1.2 Last Hit 

Tap the Last Hit switch to toggle Last Hit mode on and off. 
 
The Last Hit option can be used if there are particles between the instrument and the target which are partially 
blocking the path of the laser. The particles may be water vapour or dust in the air which may cause the laser pulse 
to reflect back to the instrument before it hits the intended target. Activating this mode will instruct the C-ALS to 
attempt to ignore any interference from the particles in the air and instead to concentrate on returns from the true 
target. 
 
The Last Hit option should not be used to shoot to reflective targets, as incorrect results may be returned. 

12.1.3 Sweep 

The Sweep selection determines the size of the vertical increment (if a horizontal scan is selected) or horizontal 
increment (if a vertical scan is selected). The smaller the increment, the more scan sweeps the C-ALS completes, 
the denser the resulting point cloud, and the longer the duration of the scan.  
 
From the Sweep drop-down list, select the required increment.  
 
To enter a user-defined increment, select Custom from the drop-down list. The number-pad opens. Enter your 
required increment and tap Accept. The smallest definable scan increment is 0.3 degrees.  
 
The entries in the drop-down list show the increment in degrees followed by (in brackets) the approximate time to 
run the scan.   
 
Note that due to the mechanics of the scanner, the actual increment and scan time may differ slightly from the 
selected value. 

12.1.4 Speed 

Select Fast or Dense from the drop-down list, to determine the speed of the scan.  
 
For most operations, leave the speed set to Fast. Alternatively, select Dense and each scan will run approximately 
70% slower, with approximately 70% more points along each scan sweep. 
 
The Dense option is mainly intended for very large voids where the spacing between each point on a scan line can 
become very large on the most distance surfaces. 
 
Note that the Sweep control defines the density of scan sweeps whereas the Speed control defines the density of 
points along each scan sweep. 

12.1.5 Custom scan 

Use the Custom scan controls to limit the range of a scan. By default, horizontal and vertical scans provide a full 
360° coverage of the area around the scan head. Sometimes, the full coverage is not required and, due to time 
constraints, it is desirable to physically limit the range of a scan. 
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Limit a horizontal scan using the vertical start and end angles. 
 
Limit a vertical scan using the horizontal start and end angles. 
 
For a C-ALS, the default ‘full scan’ range values are: 

 Horizontal: -180° to 180°. 

 Vertical: 180° to 0°. 

12.1.1 Scan controls 

The Scan controls enable scans to be started using the settings determined using the scan configuration tools. 
 

 

 Scan: With the scan configured, tap Scan to begin the scan. The Scan button is greyed out until the scan 
is complete or cancelled. 

 Pause: during a scan, tap the Pause button to interrupt a scan that is in progress. The C-ALS completes 
the current scan sweep before pausing. 

 While the scan is paused, tap Scan to continue the scan or tap Stop to abort the scan and park the C-ALS. 

 Stop: during a scan, or while a scan is paused, tap Stop to end the scan. The C-ALS and Carlson Scan 
displays a summary of the part of the completed scan.  

  

Scan, Pause and Stop buttons 

Custom scan controls 



 

P a g e  | 100 

12.2 During a scan 

Once a scan has been started, no further user intervention is required. The C-ALS will progress through the scan 
according to the configuration selected. 
 
During a scan, some controls are disabled, and others change to become more relevant for the duration of the scan. 
 

 

12.2.1 3D View 

While a scan is in progress, the graphical model of the scanner replicates the mechanical movement of the laser 
head. The laser is displayed as a red line while it is firing (although in reality the measuring laser is invisible). 
 

During a C-ALS scan 

C-ALS model during a scan 
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All points collected are displayed in real time in the 3D View. 
 
Set different views in the 3D View tabs to make it easy to switch between fixed views or between orthographic and 
perspective views. 
 
Standard controls can be used to pan, rotate and zoom the data for visual analysis during the scan (see section 
5.1). 
 
To display the 3D View in full screen mode, retract the Control tab or any other active function tab. 

12.2.2 Progress dial 

 

 A live progress dial shows the scan progress including: 

o Approximate time remaining  

o Percentage of the scan completed 

o A blue progress bar around the dial 

When the Control tab is not active, the progress information is displayed in the status bar at the bottom of the 
screen. 

12.2.3 Visualisation tools 

The visualisation tools control the appearance of the data collected in the active scan. 
 

 

 Tap the Points switch to toggle the points on and off in the 3D View. 

 Tap the Mesh switch to toggle the real-time mesh on and off in the 3D View. 

 Select a colour scheme from the drop-down list to change the colouring of the scan. Options are: 

o Solid colour: select a single colour for the scan. 

Progress dial during a scan 

Visualisation tools 
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o Intensity: scan is coloured according to the signal strength recorded for each data point. 

o Distance: scan is coloured according to the distance from the scanner. 

o Elevation: scan is coloured according to its relative height. 

Note you can open the Scan tab to further modify the view of the active scan and the real-time mesh (see section 
8). The datasets in the 3D View can also be toggled on and off in the Project tab (see section 7). 

12.2.4 Scan controls 

During a scan, the scan controls enable scans to be paused, restarted or stopped. 
 

 

 Pause: during a scan, tap Pause to interrupt a scan that is in progress. The C-ALS completes the current 
scan sweep before pausing. 

While the scan is paused, tap Scan to continue the scan or tap Stop to abort the scan and park the C-ALS. 

 Stop: during a scan, or while a scan is paused, tap Stop to end the scan. The C-ALS parks and Carlson 
Scan displays a summary of the completed scan. 

12.2.5 Scan completion 

When a scan has completed, or been cancelled, the C-ALS laser head will park in its original position. 
 
A summary of the scan appears in a message box. 
 

 
You can conduct further scans from the same station. However, if the C-ALS has been moved, a new Boretrak 
reading may need to be taken, with the appropriate value entered into the Increment drop down in the deployment 
controls.  
 

Scan, Pause and Stop buttons 

Scan summary 
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13 Desktop Mode – screen layout 

When a project has been completed, the data is usually viewed and analysed back in the office. In this case, if you 
are using a larger format laptop or desktop computer then select Desktop mode. 
 
Desktop mode has a more traditional interface and is intended for use with a standard keyboard and mouse. 
 

 
All the same functionality is present in the Desktop mode, although the UI is arranged slightly differently. There are 
also some additional features which are useful for the processing stage. 

13.1 Menu bars 

 
Many of the controls in Desktop mode are arranged into buttons in the menu bars. There are three menu bars 
which can be selected by clicking the menu bar tabs. 

13.1.1 Home 

The Home menu bar includes all the controls which are present in the Menu tab in Touch mode (see section 6). In 
addition to these controls are: 

Menu bars 

Scan panel 

Function tabs 

Multiple viewing 
panels 

Desktop mode 

Home menu bar 

Undo / Redo Menu bar tabs Layer controls 
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 Touch button: swaps the viewing mode from Desktop to Touch.  

 

 Panel button: changes the arrangement of 3D View windows in the interface. Click the panel button to be 
offered a choice of: 

o 1 Panel 

o 2 Panel 

o 3 Panel left 

o 3 Panel right 

o 4 Panel 

 

 Log: opens a series of logs which catalogue all interactions between the C-ALS or VS+ probe and Carlson 
Scan. These logs are used for troubleshooting and are not required for normal operations. 

13.1.2 Measure 

The Measure menu bar replicates the tools in the Measure tab in Touch mode (see section 9). When using these 
measure tools in Desktop mode, the results from all measuring operations are displayed in the Measure tab, on 
the right-hand side of the screen. 

13.1.3 Edit 

The Edit menu bar contains editing tools for erasing and masking data.  
 
The Undo/Redo buttons are used in conjunction with the editing tools. Details of the editing tools are in section 14. 

13.2 Function tabs 

As in Touch mode, on the right-hand side of the screen are function tabs which allow control of the scanner, provide 
data viewing and analysis tools, and enables management of the project. 
 

 The Project tab contains a record of all data collected or imported within the active Carlson Scan project 
(see section 7). 

Touch button 

Panel button 
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 The Control tab provides direct control of the connected scanner. The Control tab is configured according 
to whether a C-ALS or VS+ is connected to Carlson Scan (see sections 10, 11 and 12). 

 The Scan tab contains controls to change the appearance of the active point cloud and the mesh (see 
section 8). In the Settings window > General tab, if the Bottom Section check box is unticked, the Scan 
tab appears on the right-hand side with the other tabs. If the Bottom Section check box is ticked, all the 
tools in the Scan tab appear instead in the Scan panel at the bottom of the screen. 

 

 
The Measure tab appears when the Measure toolbar has been selected at the top of the screen. All data resulting 
from measurement functions is displayed in the Measure tab. 

13.3 Layer controls 

The Layer controls provide tools to manage the layers into which the data in the 3D View is divided. 
 

 
Select a layer from the drop down list and use the visible/invisible button to toggle the layer on and off in the 3D 
View. 
 
Select a layer from the drop down list and use the colour drop down list to configure the colour option of the layer 
in the 3D View. 
 
If you select a colour option for a layer, this overrides any colour settings for individual entities within the layer.  
 
Click the List button to open the Layers tab in the Project window. 
 

Scan panel 

Layer controls 
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The colour option of each layer can be changed in the Layers tab. Select a colouring option from the Display 
Settings drop down list.  
 

Layer tab 
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14 Editing functionality 

In Desktop mode, Carlson Scan provides tools to edit the collected data. The intention is to help data analysis 
within Carlson Scan, and also to help smooth integration with third party packages by cleaning and preparing 
collected data before it is exported. 
 
The Undo/Redo buttons are used in conjunction with the editing tools. 
 

 
The buttons shown initially in the Edit menu bar are Erase and Mask. 

14.1 Erase 

Click Erase to delete points from the project. The Edit menu bar changes to display additional tools. 
 

 
Define the manner in which points to erase are selected. 

 Rectangle: select points by drawing a rectangle. Click in one corner of the rectangle and then drag out to 
click in the opposite corner to define the selected area. 

 

 Polygon: select points by clicking in the 3D View to create a polygon. 

Edit menu bar #1 

Edit menu bar #2 

Rectangle select 
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Define the selection of points. 

 Inside: select the points inside the user-defined rectangle or polygon. 

 

 Outside: select the points outside the user-defined rectangle or polygon. 

 

 
Press ESC to cancel the selection. 
 
Press Enter to complete the erase action. The selected points are deleted from the 3D View. 
 

Polygon select 

Inside select 

Outside select 
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Use the Undo/Redo buttons to retrieve or re-delete the points. The points are deleted from the Carlson Scan 
project when the project is closed and saved. 

14.2 Mask 

Click Mask to hide points within the Carlson Scan project. A mask is a temporary way to make points invisible to 
help analysis and editing. For example, you may mask the top and bottom of a scan so that you can see and edit 
stray points inside a void. 
 
Click Mask to mask points from the project. The Edit menu bar changes to display additional tools. 
 

 

14.2.1 Creating a mask 

Define the manner in which points to erase are selected. 

 Rectangle: select points by drawing a rectangle. Click in one corner of the rectangle and then drag out to 
click in the opposite corner to define the selected area. 

 

 Polygon: select points by clicking in the 3D View to create a polygon. 

Edit menu bar #2 

Rectangle select 

Polygon select 
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Define the selection of points. 

 Inside: select the points inside the user-defined rectangle or polygon. 

 

 Outside: select the points outside the user-defined rectangle or polygon. 

 
 
Press ESC to cancel the selection. 
 
Press Enter to accept the selection. A Mask is created. The Edit menu bar changes to display additional tools. 
 

 

14.2.2 Working with a mask 

The new mask is listed on the Edit menu bar as Mask 1 button. This mask comprises selected points which can be 
analysed and edited in isolation from the rest of the data in the Carlson Scan project.  
 
If required, create more masks to use in conjunction with each other. Each additional mask is added to the Edit 

Inside select 

Outside select 

Edit menu bar #3 
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menu bar. 
 
A mask can be active or inactive. Click Mask 1 to toggle between active and inactive status. 
 
The Mask 1 button is highlighted when it is active.  
 
Any erase operations carried out while a mask is active only affects the points selected with the active mask. 
 
Click Highlight to darken/lighten all unmasked points in the 3D View. 
 

 
Click Visible to turn off/on all unmasked points in the 3D View.  
 

 
With a mask applied, analysis of the data can be clearer. 

All unmasked points darkened 

All unmasked points invisible 
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Use erase tools or additional masks to carry out more advanced editing. 
 

 
Click Clear to clear any masks from Carlson Scan. Masks are temporary viewing and editing aids so are cleared 
automatically when you exit a Carlson Scan project. 

Viewing inside a masked dataset 

Erasing data inside a masked dataset 
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A TYPICAL C-ALS 

DEPLOYMENT 
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15 C-ALS deployment - introduction 

The considerations and procedures for a typical C-ALS operation are outlined below. These include the limits of the 
system, project preparation, deployment and a basic software run-though.  
 
This operations guide is focused on C-ALS units which incorporate an IMU: either a C-ALS Gyro or a C-ALS HD.  
 
Depending on your specific site and project requirements, you may need to take a very different approach to your 
deployment. However, most of the information below is relevant to all operations, so please familiarise yourself with 
the basic best practices recommended by Carlson prior to using your system in the field and consider this to be a 
template for basic operations. 

15.1 Gyro introduction 

The C-ALS is fitted with an Inertial Measurement Unit (IMU) which incorporates a 3-axis MEMS-based gyro and a 
3-axis accelerometer. 
 
The IMU integrates information from both the gyro and the accelerometer and the output orientation is determined 
by fusing the outputs of both these sensors through a software-based Kalman filter model. 
 
The advanced IMU solution ensures that the attitude and orientation of the C-ALS probe can always be tracked as 
it is deployed along a borehole, whether it is pointing up, down or horizontal.  
 
A gyro provides more accuracy than a compass, as the gyro is not reliant on, or sensitive to, magnetic fields. 
 
There are various properties of the gyro which affect the methodology we use when deploying a C-ALS system. 
Some notes about these properties are outlined below. You should make yourself familiar with this information and 
with the performance and operation of the gyro, prior to deploying the C-ALS system. 

15.1.1 Gyro drift 

The results from a gyro drift with time. If you lay a gyro flat and absolutely still, it will output a heading. If you leave 
the gyro in exactly the same position, the heading that it outputs will gradually change, even though the gyro is not 
changing position or rotating. This is ‘drift’ and it is effectively an error that will affect data output from the gyro. 
 
In effect, from the moment the C-ALS is first aligned, the accuracy of the gyro is deteriorating due to an accumulating 
angular error. This means that the deployment operation should be as prompt and efficient as possible.  
 
The results from a gyro also drift with temperature, with severe temperature changes causing greater drift in the 
gyro output. 
 
However, processing in the C-ALS firmware and Carlson Scan software helps to mitigate these effects. Drift over 
a given time is kept to a minimum and checks on the drift throughout the deployment ensure that temperature 
changes are mostly accounted for.  
 
However, there may be situations where you are deploying in extreme temperatures or in situations where the 
temperature of the C-ALS probe on power up is completely different to that of the ambient temperature in the 
deployment area. In this case, for optimum results, you may wish to leave the C-ALS switched on for a period of 10 
to 20 minutes prior to a deployment to allow the internal temperature to stabilise.  
 
We cannot predict severe temperature changes down the borehole, but the gyro is insulated within the probe to 
some extent. As long as the deployment is as speedy as possible, any effects are dampened.  
 
In ideal circumstances, the drift of the gyro will be <1.0° per 30 minutes. 
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15.1.2 Drift alignment 

If we leave a gyro absolutely still for a period of time, we can monitor the drift and then create a model of this error. 
Each time the system is turned on, a slightly different ‘bias’ effect is exhibited in the gyro where the drift is 
experienced strongly in certain directions. Modelling these biases helps to counteract the drift so that we obtain a 
much more stable heading value from the gyro during a deployment.  
 
This process of modelling the biases is the ‘drift alignment’ which we carry out with the C-ALS prior to each 
deployment.  
 
Note that although the alignment mitigates the worst effects of drift, it does not eradicate it entirely. There are some 
random, unpredictable elements of drift which we cannot account for. 
 
After the C-ALS is switched on, the unit must undergo this drift alignment. The drift alignment is incorporated into 
the alignment process which is outlined below. 
 
During the alignment the probe should be located within the operations area, ready for the deployment to 
commence. The probe should be laid out horizontally (roughly +/- 10° from horizontal) on a solid, stable surface. A 
alignment jig is supplied to provide an easy mounting point for the probe. 
 
It is also possible to align the probe vertically and the alignment jig can be adapted for this purpose. In this case, 
the probe should be roughly +/-10° from vertical. However, horizontal alignments are usually preferable as, when 
set out horizontally, the alignment jig can be left in position for repeatable alignments at the same heading. 
 
The alignment lasts approximately 5 seconds. During this period, the C-ALS probe must be absolutely motionless. 
Site the probe away from areas where knocks or excessive vibration may occur. Any movement creates ‘noise’ for 
the gyro and renders the alignment computations less effective. If vibration is detected, the alignment may 
automatically restart multiple times before tit is successfully completed. 
 
If it is suspected that the device has moved during the alignment, or that the readings from the device seem to be 
unstable immediately after the alignment, then it is essential to re-align the device.  

15.1.3 Reference azimuth 

The gyro in the C-ALS does not output an azimuth with respect to true north. The gyro can measure the angle that 
it is rotated through as it is deployed or as it is moved around on the surface, but it cannot determine which direction 
it is pointing in when it is switched on. 
 
For this reason, we must define the starting, ‘reference’ azimuth of the C-ALS at the beginning of an operation. 
Once we have determined this starting orientation, the gyro can then keep track of the changing heading as it is 
moved around and deployed. 
 
For the purposes of a C-ALS survey, this reference azimuth is defined by surveying the orientation of the probe 
while it is in position for the alignment. 
 
The alignment jig includes mounting points for survey prisms. Using traditional survey techniques, establish the 
orientation of the alignment jig in which the probe is sat, with respect to your site coordinate system.  
 
The surveyed, starting azimuth is entered into Carlson Scan software in the Station Details window (see section 
16.11). This value can be entered before, during or after a C-ALS survey. 

15.1.4 Gyro limits 

The gyro is limited to measuring rates of rotation of up to 400°/sec in each axis. In practice this should not be a 
limiting factor providing no sudden rotational accelerations are encountered or constant rotations of greater than 
~1.1Hz are not encountered. Deploy the C-ALS probe in such a manner that minimizes rotation speeds and ensure 
that no sudden ‘jerks’ in rotation occur.  
 
If the gyro does rotate at >400°/sec in any axis, an out-of-range error will be displayed. In this case it is advised to 
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retrieve and re-align the C-ALS before starting the deployment again. 
 

 
To avoid exceeding this rotational speed limit, once the C-ALS is aligned, handle the C-ALS probe carefully as it is 
being moved into the hole. During the deployment, lower the probe carefully and steadily. Using rods to deploy the 
C-ALS helps to ensure that the probe cannot twist at all. If you do deploy on the cable alone, try to ensure as little 
rotation as possible is introduced through twist in the cable. 

15.1.5 Summary 

Taking into account the points above, there are essentially six phases of a C-ALS operation: 

 Preparation of all equipment on-site next to the deployment location. 

 An ‘alignment’’ period of approximately 5 seconds where the C-ALS probe is mounted on the alignment jig. 
During this period, the gyro biases are modelled. 

 Use traditional survey techniques to survey the reference azimuth: the heading of the probe while it is 
undergoing the alignment (this can be carried out at any stage of the operation).  

 Deployment. 

 Scan. 

 Retrieval.  

15.2 General C-ALS System limitations 

As well as the limitations of the internal gyro, also consider the general C-ALS system limitations and take these 
points into account when preparing and carrying out all C-ALS operations. 
 
The C-ALS is waterproof up to a depth of 1 m. It can move mechanically in waterlogged environments, but will not 
produce data in these circumstances. 
 
The surface unit is not watertight when its lid is open. It is thus advisable that the lid should be closed once the unit 
has been switched on. 
 
If the probe is being deployed through a borehole, it is recommended that the hole should be lined to reduce wear 
and tear on the unit and to reduce any flow of water over the unit. 
 

Gyro exceeded rotational speed limit 
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The laser ranges up to a limit of 150 m. However, the maximum achievable range at any given time or location will 
depend on a number of factors. The following factors will limit the range to some degree and in some circumstances 
may prevent any readings from being taken: 

 Dark, light-absorbent surfaces such as coal. 

 Very dusty environments. 

 Wet, slick, shiny or very smooth surfaces. 

 An acute angle between the laser and the surface. 

The minimum range of the laser is around 0.5 m. At shorter distances, readings may still be recorded, but their 
precision will be severely diminished. 
 
If the C-ALS is deployed down a borehole, then the scan head and the rotating horizontal shaft must be free of the 
hole to allow unrestricted motion. However, the probe must not be deployed so far that its full length flops out of the 
borehole. If this occurs, it may be impossible to retrieve the unit. 
 
Always monitor the borehole camera during the entire deployment. This is to gauge exactly the distance from the 
collar to the ‘breakout’ point, as well as to check the condition of the borehole. Failure to monitor the camera image 
may result in the C-ALS being damaged or lost in the borehole. In some cases, a separate borehole camera may 
be deployed first before the C-ALS is used, to check whether the conditions in the hole are suitable for the C-ALS. 
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16 C-ALS deployment - preparation 

16.1 General considerations 

When using the C-ALS system, allow adequate time before the survey to plan out the logistics of the project and to 
prepare the equipment for the deployment.  
 
Prior to deployment of the C-ALS, check the area in which the deployment will take place. Consider:  

 What is the level of accessibility at the site for personnel and vehicles? 

 Is there space to unspool and lay out the main C-ALS cable? 

 Is there any potential for interference from passing traffic that may disturb the equipment mid-scan? 

 Is there a suitable location for setting up a base for the tablet? 

 Which power supply will you use: supplied battery, other 12 V battery, or ac power?  

 Will the power source last for the intended operations? 

 Are there any requirements for backup power for the tablet? For example, a spare battery or an invertor. 

 What is the size of void: can this be scanned from one location? Are all areas of interest visible and in range 
from the proposed instrument location?  

 What are the atmospheric conditions? Thick dust clouds, mist or high humidity, very bright lights pointing 
straight at the proposed laser location: these can all affect the data quality. 

 Is there a convenient way of stabilising and securing the C-ALS system when it is scanning? 

 Where will any winches and tripods being used to assist the deployment be positioned?  

16.2 Alignment jig 

In addition to these standard considerations, when using a C-ALS you must determine an appropriate location for 
the alignment to be carried out. This is either a location for the horizontal jig to be set out, or a location (most likely 
the top of the borehole) for the probe to be suspended on the jig vertically. 
 

C-ALS mounted horizontally on a gyro jig 
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The location must be close enough to the project site so that the C-ALS can be promptly deployed when the 
alignment is complete. Take care that the cable run is not going to obstruct an access route or cause a trip hazard. 
 
The location should be solid and not subject to movement or vibrations.  
 
The survey to establish the reference azimuth can take place at any time. If convenient, you can set out the 
alignment jig well before the C-ALS deployment takes place, or leave it set up after the deployment is completed. 
As long as the alignment jig is not moved, the surveyor can then use the total station to establish the reference 
azimuth when the C-ALS survey is not in progress. 
 
However, if the alignment jig is being used for a vertical alignment at the top of the borehole, the reference azimuth 
must be established at the time of the C-ALS alignment, as the alignment jig must be moved as soon as the 
deployment commences. 

16.3 Deployment method preparation 

It is possible to deploy the C-ALS directly into a borehole on a cable alone. However, there may be some 
circumstances where it is still advisable to use Boretrak rods to stabilize the probe during deployment and during 
the scanning process. 
 
Boretrak rods are certainly required if the borehole is horizontal or uphole. In this case the probe must be pushed 
with the rods. 
 
Using rods with a C-ALS system ensures that the probe cannot exceed the 400°/sec maximum rotation rate during 
a deployment. 

C-ALS mounted vertically on a gyro jig 
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17 C-ALS deployment – in the field 

17.1 Setting up the equipment 

If a slip ring cable drum is NOT being used, unspool the length of cable that is required for the deployment. Lay out 
the cable neatly in such a way that it can be fed into the borehole without tangling or disrupting the deployment. 
 
Thread the strained connector through the extension piece and screw firmly onto the C-ALS probe. Connect the 
extension piece to the C-ALS probe by mating the alignment pins and screwing the brass tightening screws around 
the cover piece.  
  

 
Connect the other end of the main cable to the surface unit.  
 
Connect the surface unit to the selected power supply. Power the surface unit on. As soon as the surface unit is 
powered up, the probe initialises by rotating the scan head to register the encoders’ zero index marks. Therefore, 
be sure that the horizontal and vertical axes of the probe are free to rotate for this start-up procedure. 
 
If you are using rods, locate the stack of rods on a firm, stable surface at a convenient distance from the collar 
position to allow easy deployment of the rods.  
 
If the probe is to be deployed uphole, or at a near-horizontal angle, then it will be necessary to ‘push’ the rods during 
deployment, rather than just lowering them with the assistance of gravity. In this case, uphole links should be fitted 
between each rod. These are shaped slightly differently to the standard hinges and will ensure that the rods do not 
fold back on themselves when the rods are pushed. 
 
It is not necessary to survey the azimuth of the rod rack or to worry about the exact alignment of the rods in relation 
to the borehole. 
 
Both the cable and rods can take the strain of the C-ALS system, although it is recommended that, when possible, 
the weight of the deployed system is borne by the cable. 

Connecting the C-ALS probe to the extension piece 
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17.2 Warm-up period 

For most operations, you may skip this stage. However, there may be situations where you are deploying in extreme 
temperatures or in situations where the temperature of the C-ALS probe on power up is completely different to that 
of the ambient temperature in the deployment area. For example, if the C-ALS has been inside in a heated 
environment and the deployment is in freezing conditions, or if the C-ALS has been kept in an air-conditioned 
environment and the probe is cold to the touch, but the deployment is in extreme heat. In these cases case, for 
optimum results, you may wish to leave the C-ALS switched on for a period of 10 to 20 minutes prior to a deployment 
to allow the internal temperature to stabilise.  
 
In this case, when setting up the equipment, try to get to the stage where the probe is powered on as soon as 
possible. This ensures that the warm-up period is started promptly while some of the other equipment setup is still 
continuing. This makes the most efficient use of your time in the field. 
 
Do not switch the C-ALS system off between starting the warm-up period and starting the deployment. When the 
C-ALS is first switched on, and when it is located in position to carry out the alignment, the C-ALS should be in a 
state that is ready to deploy without powering down. 
 
Note that during the warm-up period the C-ALS probe must switched on, but it does not have to be located ready 
to align, nor does it need to be held stable. However, it is probably most convenient and efficient if, while warming 
up, the probe is in position ready for the alignment. 
 
The tablet does not have to be connected to the C-ALS system during this warm-up period.  

17.3 Setting up Carlson Scan 

Connect the surface unit to your tablet using the Ethernet cable, or via a Wi-Fi connection. An icon on the Windows 
taskbar will indicate when the network has been successfully established. At this point, open Carlson Scan and 
begin a new project. 
 
From the Touch mode Home screen, tap Start. 
 
The Project window opens. Edit the details as required. You can enter hole positions in advance, give the project 
an appropriate name and change the default folder location.  
 
Tap Create to accept the entered details and create a new project. 
 
Carlson Scan immediately runs an auto-detect process to identify the C-ALS. 
 
When a scanner is identified, the connection is made.  
 
The Station Details window appears (see section 7.2.1). Enter your station coordinates, or just accept the default 
values. Tap Finish. 
 
With all checks complete, a graphic of the C-ALS appears in the 3D View.  
 
The Control tab is active, displaying C-ALS-specific controls. The video window displays a video feed from the 
borehole camera. 
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The Align Gyro button is red. The gyro requires alignment before you can proceed.  
 

17.4 Alignment 

During the alignment, the C-ALS probe must be absolutely stable: free from any vibrations, shocks and movement. 
If any movement is detected, the alignment will fail. 
 
The heading in which the probe is positioned during the alignment is used to define the starting orientation of the 
C-ALS deployment. Whichever way the probe is positioned, the heading of the probe should be established by 
surveying the alignment jig. All gyro readings thereafter will be related back to this aligned heading. 
 
Use the supplied prisms as targets to observe to with a total station. 
 
If you are aligning the C-ALS probe horizontally, survey the heading of the probe from the end of the extension 
piece to the laser head. If appropriate, the jig can be left in place for the duration of an operation and, once the 
heading has been surveyed, and as long as the jig is not moved, the same heading value can be used for multiple 
deployments. The heading of the jig can be established – and entered into Carlson Scan – before, during or after 
the alignment and C-ALS deployment. 
 
For vertical alignments, the jig’s horizontal crossbar provides the reference heading for the survey. A sticker on the 
crossbar illustrates the direction to survey. 
 
When the probe is in position, tap the Align Gyro button to carry out the gyro alignment.  
 

Connected to a C-ALS 

Gyro - unaligned 
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A message appears: “Are you sure you want to align the Gyro?” Tap Yes. 
 
The Alignment setup window appears. 
 

 
Enter the heading of the alignment jig, if known at this stage.  
 
The gyro button progresses through its various states: Aligning Gyro, Verifying Alignment, and then Aligned 

 

 
The deployment can now proceed. 

  

Gyro – aligned 

Alignment settings window 
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17.5 Deployment 

From the deployment controls, select your required Interval, usually 2m. 
 

 
At the start of the deployment, transfer the C-ALS into the borehole. The whole probe should be deployed, plus the 
extension piece up to the rod connector at the end of the extension piece. It is exactly 2 m from the centre of the 
rod connector back to the reference point at the centre of the vertical pivot.  
 
Sufficient time should be left before each Boretrak reading, and before a scan is started, to allow the probe and its 
internal sensors to stabilise. 
 
Tap the Take Reading button to record the first Boretrak reading. 
 
The Length and Segments text increase accordingly after each reading. 
 
Each stage of the deployment is displayed graphically in the 3D View.  
 
At each interval, steady the probe, take a reading and, as soon as the information on-screen has updated, continue 
the deployment.  
 
The deployment interval can be changed at any time.  
 
Monitor the video window at all times during the deployment. To make the video image clearer, use the Resize 
button to swap the 3D View with the video window. 
 
You must note the point at which the nose of the probe leaves the borehole and enters the void. Take great care 
from this point onwards not to push the C-ALS so far into the void that the whole length flops out of the borehole 
and becomes impossible to retrieve. However, the C-ALS must be far enough out of the borehole that the vertical 
and horizontal pivots are free to move mechanically, and that the laser head has enough room to turn through its 
full range of motion. 

17.6 Final position 

When the probe reaches the final scanning position it is likely that, for the last Boretrak reading, the probe cannot 
be deployed by exactly the distance previously specified. For example, although a 2 m interval may have been in 
use, the final deployment may need to be just 0.5 m to achieve the best position for the probe to take the scan, or 
to avoid the probe dropping out of the end of the borehole. Thus, before the final Boretrak reading is taken, change 
the Interval to Custom and then enter the actual deployment distance before taking the reading. 
 
If the exit from the borehole into the void is not clear-cut, it is often advisable to run a Circle scan to check whether 
the probe has completely broken clear of the borehole. The circle scan does not involve any vertical movement of 
the laser head, so if the probe is still within the borehole, there is no risk of it being caught against a rockface. 
However, the observed ring of points will allow you to determine whether the C-ALS probe is clear to carry out a full 

C-ALS deployment controls 
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scan.  
 
If necessary, the C-ALS can be deployed a little further into the void. In this case, enter the correct Interval value 
and take another Boretrak reading. This ensures that the position of the C-ALS probe is always correctly recorded 
in Carlson Scan. 
 
If the system is going to be tied and secured into place for a long scan, it is advisable to do this prior to taking the 
last reading. Failure to do this could lead to the probe moving before the scan commences, resulting in incorrectly 
positioned data. 
 
The data recorded at the final Boretrak reading informs Carlson Scan of the attitude of the probe when the scan 
starts. It is assumed the probe will not move during the scan, therefore the unit must not be moved after the last 
Boretrak reading until the end of the scan. 
 
Switch to the Scan controls. The deployment controls are replaced by scan controls. 
 
Setup a scan using the C-ALS scan configuration tools. 
 

 
Set the Active Scan pattern and the Sweep. 
 
Tap Scan to begin the scan. 
 

17.7 During a scan 

Once a scan has been started, no further user intervention is required. The C-ALS progresses through the scan 
according to the configuration selected. 
 
All points collected are displayed in real time in the 3D View. Retract the active function tab to switch the 3D View 
to full screen 

Scan, Pause and Stop buttons 

Scan controls 



 

P a g e  | 126 

 

 
A live progress dial shows the scan progress. 
 

17.8 After the scan 

When a scan has completed, or been cancelled, the C-ALS laser head parks in its original position. 
 
A summary of the scan appears in a message box. 
 

 
You can conduct further scans from the same station if the C-ALS has not physically moved.  
 

Scan summary 

Progress dial during a scan 

C-ALS in the 3D View during a scan 
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To ensure the scan is correctly geo-referenced, tap the Station Details button. 
 

 
The Station Details window opens. 
 

 
Enter the surveyed Collar location: the position from where the deployment was started. 
 
Tap Accept. 
 
In the Menu tab, tap Save.  
 
Tap Exit to close Carlson Scan. 

  

Station window - C-ALS operations 

Active station controls 
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A TYPICAL VS+ 

DEPLOYMENT 
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18 VS+ deployment – introduction 

The considerations and procedures for a typical boom-mounted VS+ operation to scan a stope are outlined below. 
These include the limits of the system, project preparation, deployment and a basic software run-though. 
 
Depending on your specific site and project requirements, you may need to take a very different approach to your 
deployment. However, most of the information below is relevant to all VS+ operations, so please familiarise yourself 
with the basic best practices recommended by Carlson prior to using your system in the field and consider this to 
be a template for basic operations. 

18.1 System limitations 

Note the limitations of the VS+ below and take these points into consideration when preparing and carrying out 
operations with the system. 
 
The VS+ is water-resistant (IP65) but should not be submerged.  
 
Sensors are incorporated into the VS+ to monitor the position of the instrument during its deployment and to correct 
the data when the unit is inclined during a scan. The unit can produce scan data while positioned at any angle. 
However, readings should not be taken if the probe itself is moving, swinging or unstable in any way. If the probe 
does move during a scan, no account of this is taken in the collected data. A warning message will appear once the 
scan is complete, noting that the VS+ has moved. You should then make a judgement as to whether the scan needs 
to be restarted.  
 
The internal sensors measure the inclination and roll of the VS+. When the instrument is within 1° of being vertical, 
the roll value becomes impossible to calculate due to the sensor’s position in relation to gravity. In this case, the roll 
value will be forced to 0°. Scans will still be accurately levelled, but the orientation of the scan will be difficult to 
measure correctly. For this reason, we recommend that, where possible, the instrument should be used at 
inclinations of greater than 1°.  
 
The laser ranges up to a limit of 150 m to 90% reflective material. However, the maximum achievable range at any 
given time or location will depend on a number of factors. The following factors will limit the range to some degree 
and in some circumstances may prevent any readings from being taken:  

 Dark, light-absorbent surfaces such as coal  

 Very dusty environments  

 Wet, slick, shiny or very smooth surfaces  

 An acute angle between the laser and the surface  

The minimum, calibrated range of the laser is 0.5 m. At shorter distances, readings may still be recorded, but their 
precision will be severely diminished. 

18.2 Geo-referencing VS+ data 

A number of values are required to ensure that all data collected with a VS+ can be fully geo-referenced into the 
local site coordinate system. 
 
The ‘scan origin’ in the VS+, to which all measurements are made and referenced, is a point inside the unit in the 
centre of the trunnion axis. This point needs to be computed by Carlson Scan to establish the true position on the 
VS+. 
 
The VS+ incorporates two threads for mounting a prism at fixed locations on the instrument. With a prism screwed 
onto either one of these mounting points, use traditional survey techniques to establish the position of the prism 
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within your local site coordinate system. The offsets from both prism locations to the scan origin are hard-coded 
into Carlson Scan. 
 

 
 
Another prism is required to take another survey observation to the back of the boom on which the VS+ is mounted. 
The heading from this second prism to the prism on the VS+ gives the reference azimuth for the VS+ survey. 
 
The last required values are gathered automatically by the accelerometers mounted in the VS+. These 
accelerometers establish the probe’s inclination and roll when it is deployed and ready to scan. 
 
With the all these values determined, the position of each of the observed points in the scan can be calculated from 
the individual range and bearing measurements. As long as all coordinates that are used are on the same datum, 
multiple scans from different stations can be combined together in Carlson Scan or exported into third-party 
software. 
 
In Carlson Scan, a VS+ Station incorporates all these values and displays the scan origin (see section 7.2.3). The 
prism mounting point, prism coordinates and reference azimuth can all be edited post-survey. However, the 
inclination and roll are fixed as soon as the first scan from a given station is started. Therefore, once the VS+ has 
shifted position, a new Station should be created, and subsequent scans run from this new location. 

Front prism 
mount 

Rear prism 
mount 

Scan origin at the 
centre of the 
trunnion axis 

Fixed offsets from 
prism positions to 

scan origin 

Prism mounting locations 
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19 VS+ deployment - preparation 

Prior to deployment of the VS+, check the area in which the deployment will take place. Consider:  

 What is the level of accessibility at the site for personnel and vehicles? 

 Is there space to unfold the boom and lay out any cables and accessories? 

 Is there any potential for interference from passing traffic that may disturb the equipment mid-scan? 

 Is there a suitable location for setting up a base for the tablet? 

 Which power supply will you use: will you require an external battery to supplement the internal battery? 

 Will the power source last for the intended operations? 

 Are there any requirements for backup power for the tablet? For example, a spare battery or an invertor. 

 What is the size of void: can this be scanned from one location? Are all areas of interest visible and in range 
from the proposed instrument location?  

 What are the atmospheric conditions? Thick dust clouds, mist or high humidity, very bright lights pointing 
straight at the proposed laser location: these can all affect the data quality. 

 Is there a convenient point to act as a rest for the boom?  

 Is there a convenient way of stabilising and securing the boom? 
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20 VS+ deployment – in the field 

20.1 Setting up the equipment 

Assemble the boom. 
 
Attach the VS+ securely to the boom. Attach the prism to a prism mount location on the VS+. 
 
Connect the main cable to the VS+. Where appropriate, secure the cable to the side of the boom. 
 
Deploy the boom into the void, ensuring that the instrument’s sight lines within the void are optimised and that the 
instrument is as far clear of the sidewalls as possible. Unspool the cable along the boom. 
 
Attach a second prism to the back end of the boom. The azimuth that defines the orientation of the survey is that 
from the prism on the boom to the prism on the instrument. 
 
Note that the prism on the boom should be aligned with the prism on the probe. As far as possible, ensure the probe 
is upright so that the attached prism is pointing directly upwards. The prism on the end of the boom should then 
also be directly on top of the boom. Any misalignment between the prisms will cause the calculation of azimuth to 
be incorrect. 
 
Use a total station to shoot in both prisms within the mine’s co-ordinate system. Note that to make the most efficient 
use of your time in the field, this stage can be completed while the VS+ scan is in progress. 
 
Turn on the VS+. Establish a connection between the VS+ and the tablet. 
 
When powered up, the VS+’s horizontal and vertical motors will turn, and the laser head will park in its home position. 
 
Start Carlson Scan software. 

20.2 Setting up Carlson Scan 

From the Touch mode Home screen, tap Quickstart. 
 
Carlson Scan searches through all available COM ports and IP connections for scanners connected to the tablet. 
 

 
On detection of a scanner, Carlson Scan runs through checks to establish that comms with the scanner are sound. 
 
With all checks complete, a graphic of the VS+ appears in the 3D View.  
 

Connecting to a scanner 
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The Control tab is active, displaying VS+-specific controls. 
 
Setup a scan using the VS+ scan configuration tools. 
 

 
Set the Active Scan pattern and the Increment. 
 
Tap Scan to begin the scan. 
 

 

20.3 During a scan 

Once a scan has been started, no further user intervention is required. The VS+ progresses through the scan 
according to the configuration selected. 
 
All points collected are displayed in real time in the 3D View. Retract the active function tab to switch the 3D View 
to full screen. 
 

 
A live progress dial shows the scan progress. 

Scan configuration tools 

Scan controls 

VS+ in the 3D View during a scan 
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Open the Scan tab to modify the view of the active scan and the real-time mesh. 

20.4 After the scan 

When a scan has completed, or been cancelled, the VS+ laser head parks in its original position. 
 
A summary of the scan appears in a message box. 
 

 
You can conduct further scans from the same station if the VS+ has not physically moved. However, you must 
create a new station whenever the VS+ has been moved, as only one set of inclination and roll values apply to any 
given station. 
 
To ensure the scan is correctly geo-referenced, tap the Station Details button. 
 

 
The Station Details window opens. 

Progress dial during a scan 

Scan summary 

Station controls 
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Select the Prism position as Front or Rear, which is the position on the VS+ where the prism was mounted. 
 
Enter the Prism position coordinates which were surveyed with the total station. 
 
Enter the Azimuth Offset which is the surveyed heading of the boom. 
 
Tap Accept. 
 
In the Menu tab, tap Save.  
 
Tap Exit to close Carlson Scan. 

  

Station window – VS+ operations 
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TROUBLESHOOTING 
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21 Troubleshooting guides 

Some of the most common support questions relating to equipment deployments and to Carlson Scan software 
are outlined below. These are divided into sections concentrating on VS+ operations, C-ALS operations, point 
clouds and Carlson Scan software operations. 
 
If you experience any problems with your hardware, software or with the results of field operations, check the list to 
find the cause and action, and also a reference to the relevant section in this manual. 
 
It is strongly advised that, should any fault occur which is not listed, or if the recommended action does not rectify 
the fault, you should contact Carlson. 
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22 VS+ deployments 

 

Instrument does not power up when connected to power 

Cause Remedy Reference in manual 

Cables not connected. Cables not connected Ensure all 
connections are in good condition and 
plugged in. 

See VS+ hardware manual. 

Battery not charged. Ensure the battery is charged prior to 
scanning operations. 

See VS+ hardware manual. 

 

Scan incorrectly tilted 

Cause Remedy Reference in manual 

Pitch-and-roll sensors out of 
calibration. 

Check the unit by scanning a flat, 
square room. Check the floor is level. 
If not, contact Carlson to arrange 
recalibration. 

1.1 Dear customer. 

VS+ moved during a scan or between 
two scans taken from the same 
station in Carlson Scan. 

Start a new station and rescan. 
Ensure VS+ is stable throughout the 
scan. 

10.7 During a scan. 

Using an unsupported instrument. Carlson Scan supports VS+ units, but 
not Void Scanner units from 
Renishaw or MDL. 

3.1 Equipment compatibility. 

 

Scan incorrectly orientated 

Cause Remedy Reference in manual 

Azimuth calculated incorrectly. Measure the azimuth from a target on 
the rear of the boom towards the 
target on the VS+. Keep the 
instrument as up-right as possible, 
with the prism on top. 

17.2 Geo-referencing VS+ data. 

7.2.3 Station Setup tab – VS+. 

Boom moved between scan and 
azimuth observations. 

The boom and the VS+ must be 
stationary while the scan is taking 
place and observations are made to 
prisms. 

17.2 Geo-referencing VS+ data. 

7.2.3 Station Setup tab – VS+. 
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23 C-ALS deployments 

Instrument does not power up when connected to power 

Cause Remedy Reference in manual 

Cables not connected. Cables not connected Ensure all 
connections are in good condition and 
plugged in. 

See C-ALS hardware manual. 

Battery not charged. Ensure the battery is charged prior to 
scanning operations. 

See C-ALS hardware manual. 

Main cable or power cables 
damaged. 

Check all pins, connectors and cables 
for signs of damage. 

See C-ALS hardware manual. 

 

Cannot connect your tablet to the surface unit 

Cause Remedy Reference in manual 

Ethernet cable not connected.  Ensure all connections are in good 
condition and plugged in. 

See C-ALS hardware manual. 

Tablet Wi-Fi not switched on. Use standard Windows controls to 
activate your tablet’s Wi-Fi function. 

 

Not connected to surface unit Wi-Fi. Use standard Windows controls to 
ensure that the tablet’s Wi-Fi is 
connected to the correct network. 
Alternatively use Carlson Scan Wi-Fi 
manager. 

11.1.2 Wi-Fi connection. 

 

Connected to surface unit, but cannot communicate with C-ALS probe 

Cause Remedy Reference in manual 

‘Empty firmware’ message in Carlson 
Scan Tablet indicates no comms to 
probe.  

Faulty cable between surface unit and 
C-ALS probe. 

Check, test or replace the cable 
between surface unit and C-ALS 
probe. 

See C-ALS hardware manual. 

C-ALS probe faulty. Check whether 
probe scan head is initialising when 
power is applied.  

Contact Carlson for support. 

 

1.1 Dear customer. 

 

Scan incorrectly tilted 

Cause Remedy Reference in manual 

Sensors out of calibration. Check the unit by scanning a flat, 
square room. Check the floor is level. 
If not, contact Carlson to arrange 
recalibration. 

1.1 Dear customer. 

C-ALS moved during scan. Check text report for indication that 
pitch-and-roll have changed during 
scan. Try rescanning same location. 
Ensure unit is stable throughout the 
scan. 

12.3 During a scan. 

Using an unsupported C-ALS. Carlson Scan supports C-ALSs 
running firmware version 6.1 and 
above. 

3.1 Equipment compatibility. 
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Scan orientated incorrectly  

Cause Remedy Reference in manual 

Gyro deployment – azimuth measured 
the wrong way.  

Horizontal alignment – measure along 
the probe from the rod adaptor to the 
laser head. 

Vertical alignment – measure the 
alignment bar as indicated on the 
attached sticker. 

16.2 Alignment jig 

Gyro lost alignment before scanning. Handle the probe carefully after an 
alignment.  

15.1 Gyro introduction 

Too long since last alignment. Gyro 
has suffered drift. 

Minimise the time between an 
alignment and a deployment.  

Align before every deployment. 

15.1 Gyro introduction 

 

Gyro errors 

Cause Remedy Reference in manual 

Gyro will not calibrate Probe is moving or vibrating during 
the alignment. Probe must be 
completely stable. 

15.1.2 Drift  

Gyro rotation error message. Maximum rotational speed of the C-
ALS probe body during gyro 
deployments is 400° per second. 

15.1.4 Gyro limits 

‘Align Gyro’ button does not appear 
on Control tab. 

Electronic fault. Contact Carlson for 
support. 

1.1 Dear customer 

Viewing live scan, the data appears 
distorted and tilted. 

Carlson Scan corrects gyro scans for 
drift and rotation of the probe during a 
cable-only deployment. Allow the 
scan to complete and the data is 
corrected automatically. 

 

 

Scan in wrong location 

Cause Remedy Reference in manual 

Boretrak readings missed out. C-ALS 
appears to be not deployed far 
enough. 

Ensure the correct number of 
Boretrak readings are taken during 
the deployment.  

17.5 Deployment 

Extra Boretrak readings taken. C-ALS 
appears to be deployed too far. 

Ensure the correct number of 
Boretrak readings are taken during 
the deployment. 

17.5 Deployment 

Incorrect Interval value used. Ensure the correct Interval value is 
used, and that it is updated if you use 
different intervals during the 
deployment. 

17.5 Deployment 

Collar coordinates incorrect. Enter the correct collar coordinates, 
before or after the deployment.  

17.2 Station 
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24 Point clouds 

No points being displayed during a scan 

Cause Remedy Reference in manual 

Zoomed in or out too far in 3D View. Use the mouse wheel or shortcut 
keys to zoom in or out. 

5.1 3D View 

Different entities in the project have 
coordinates separated by a huge 
distance.  

Check all station coordinates and 
coordinates of any imported data. 

 

Laser windows are dirty and no scan 
data is being collected. 

Clean laser windows carefully. See C-ALS hardware manual. 

Laser electronics faulty. Contact Carlson to arrange for 
service. 

1.1 Dear customer 

 

‘Holes’ in the point cloud 

Cause Remedy Reference in manual 

Standing water or very unreflective 
surfaces such as coal are present. 

None. Laser ranging to wet or very 
dark surfaces is unpredictable. 

17.1 System limitations 

Some surfaces in the void are beyond 
the range of the laser. 

Redeploy the VS+ from another 
location if possible and combine 
scans to overcome range limitations. 

17.1 System limitations 

Line-of-sight blocked by rocks, pillars, 
debris etc. 

Redeploy the VS+ from another 
location if possible and combine the 
scans to overcome shadowing. 

17.1 System limitations 

 

Point cloud is ill-defined and ‘fuzzy’ 

Cause Remedy Reference in manual 

Dust or moisture in the void is 
interfering with the laser. 

Switch on the ‘last-hit’ option. 10.5 VS+ scan configuration. 

12.1.2 C-ALS scan configuration. 

Standing water, running water or wet 
surfaces present in the void. 

None. Laser ranging to wet surfaces 
is unpredictable. 

17.1 System limitations 

 

Point cloud spherical either wholly or in part 

Cause Remedy Reference in manual 

Thick dust or moisture clouds in the 
void are interfering with the laser. 

Switch on ‘last-hit’ option. If the 
problem persists, wait for dust or 
moisture to clear, if feasible. 

10.5 VS+ scan configuration. 

12.1.2 C-ALS scan configuration. 
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CARLSON SCAN EULA 
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License Agreement 

Copyright Carlson Software All Rights Reserved 
 
CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE 
 
Please read the following Software License Agreement before using the SOFTWARE. Using this SOFTWARE 
indicates that you have accepted its terms and conditions.  
 
IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal 
agreement between you (either an individual or a single entity) and Carlson Software, Inc for the software 
accompanying this EULA, which includes computer software and may include associated media, printed 
materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising 
your rights to use the SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to the 
terms and conditions of this EULA, you may not use the SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS 
AND CONDITIONS OF THIS EULA, DO NOT CLICK THE "ACCEPT" BUTTON, AND DO NOT INSTALL OR USE 
ANY PART OF THE SOFTWARE. 
 
Carlson Software, Inc., referred to as "LICENSOR", develops and/or licenses proprietary computer programs and 
sells use licenses for such proprietary computer programs together with or apart from accompanying copyrighted 
material and documentation and; 
 
End User desires to obtain the benefits thereof and, in return for which, is willing to abide by the obligations and 
fee agreements applicable to LICENSOR's use licenses in LICENSOR's proprietary computer programs. 
 
For good and valuable consideration, including but not limited to license grant in accordance with this Agreement 
by LICENSOR to End User's covenant regarding LICENSOR's proprietary rights, LICENSOR agrees to permit 
End User to utilize materials representing LICENSOR's product or products subject to the following terms and 
conditions: 

License Grant 

Subject to the terms, conditions and limitations of this EULA, LICENSOR hereby grants End User a personal, 
limited, non-exclusive, non-transferable, license to utilize the Software Product you have purchased. The license 
granted in this EULA creates no license, express or implied, to any other intellectual property of Licensor, except 
for the specific Software Product which they have lawfully purchased from LICENSOR.  
 
This EULA grants you the following rights:  
 
You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating 
system, on a single computer.  
 
A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.  

Exclusive Source 

End User shall obtain all LICENSOR authorized product materials through LICENSOR or LICENSOR'S 
authorized representative and no other source. LICENSOR authorized product materials include, but are not 
limited to, manuals, license agreements and media upon which LICENSOR's proprietary computer programs are 
recorded. End User shall make no copies of any kind of any of the materials furnished by LICENSOR or 
LICENSOR's authorized representative, except as specifically authorized to do so in this EULA. End User is not 
entitled to make archival copies of those portions of LICENSOR's product(s) that are provided on a machine-
readable media. 

Proprietary Rights of Licensor 

End User agrees that LICENSOR retains exclusive ownership of the trademarks and service marks represented 
by its company name and logo and all of the documentation and computer recorded data related thereto. End 
User also agrees that all techniques, algorithms, and processes contained in LICENSOR's computer program 
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products or any modification or extraction thereof constitute TRADE SECRETS OF LICENSOR and will be 
safeguarded by End User, but in no event shall End User exercise less than due diligence and care in accordance 
with the laws of the country of purchase and International Law, whichever operates to best protect the interests of 
LICENSOR. End User shall not copy, reproduce, re-manufacture or in any way duplicate all or any part of 
LICENSOR products WHETHER MODIFIED OR TRANSLATED INTO ANOTHER LANGUAGE OR NOT, or in 
any documentation, or in any other material provided by LICENSOR in association with LICENSOR's computer 
program products regardless of what manner of storage and retrieval the product exists, except as specified in 
this Agreement and in accordance with the terms and conditions of this Agreement which remain in force. End 
User agrees that in the event End User breaches this EULA, End User will be liable for damages as may be 
determined by a court of competent jurisdiction.  

Restrictions 

End User’s rights and obligations under this EULA are nonexclusive and personal in nature, and the intellectual 
property Licensor grants to End User is subject to applicable law other than bankruptcy law. End User may not 
transfer or assign the SOFTWARE, rights under this EULA or accompanying user documentation, or any updates 
of the SOFTWARE which may be provided under this EULA, to a third party unless End User receives written 
consent from Licensor at least 30 days prior to the completion of transfer. Licensor reserves the right to deny 
transfer or assignment if, in its sole discretion, Licensor determines the transfer not to be a necessity. Whether or 
not a transfer or assignment is allowed shall be determined in Licensor’s sole discretion after taking into 
consideration certain factors to find the existence of a necessity including, but not limited to, merger or acquisition 
of an entity, complete asset acquisition, change of control, severe economic hardship, severe loss of human 
resources or significant loss in business divisions, or winding down of entity affairs.  
 
If Carlson consents to a transfer, such transfer shall be allowed only as a one-time permanent transfer of this 
EULA and Software to another end user, provided the initial End User retains no copies or previous versions of 
the Software. The transfer must include all of the Software, including all component parts, any media and printed 
materials, any upgrades, this EULA, and any associated license key. The transfer may not be an indirect transfer, 
such as a consignment, rental or lease. No corresponding Maintenance Agreement rights shall transfer with the 
SOFTWARE transfer to the subsequent end user. Prior to the transfer, the subsequent end user receiving the 
Software from the initial End User must agree to all terms of this EULA, with the added condition that no further 
transfers to third parties are permitted for any reason whatsoever, and shall agree to the terms and conditions of a 
new Maintenance Agreement with Licensor.  
 
You may not reverse engineer, decompile, or disassemble the SOFTWARE or alter the images utilized in the 
SOFTWARE and user documentation. The SOFTWARE PRODUCT is licensed as a single product. Its 
component parts may not be separated for use on more than one computer. You shall communicate to any 
individual user in your facility that they are bound by the restrictions of this license agreement may not copy or 
alter the SOFTWARE for use outside End User's facilities.  
 
Upgrades. If you purchase an upgrade of a SOFTWARE PRODUCT and you use it on different machine from one 
where upgraded SOFTWARE PRODUCT was used, use of original SOFTWARE PRODUCT must be 
discontinued and confirmed within 30 days. If such use is not discontinued, it is a material breach of this EULA 
and LICENSOR shall be entitled to all remedies available to it under this EULA, and under the laws of Kentucky, 
USA.  

Security Mechanisms 

Licensor and its affiliated companies take all legal steps to eliminate piracy of their software products. In this 
context, the Software Product may include a security mechanism that can detect the installation or use of illegal 
copies of the Software Product, and collect and transmit data about those illegal copies. Data collected may 
include any location and customer data created with the Software. Carlson reserves the right to utilize this 
information for both security and research and development of its security mechanisms. By using the Software 
Product, you consent to such detection and collection of data, as well as its transmission and use if an illegal copy 
is detected. Licensor also reserves the right to use a hardware lock device, license administration software, and/or 
a license authorization key to control access to the Software. You may not take any steps to avoid or defeat the 
purpose of any such measures. Use of any Software without any required lock device or authorization key 
provided by Licensor is prohibited.  
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Audit Rights 

End User agrees that LICENSOR has the right to require an audit (electronic or otherwise) of the LICENSOR 
Materials and the Installation thereof and access thereto. As part of any such audit, LICENSOR or its authorized 
representative will have the right, on fifteen (15) days’ prior notice to End User, to inspect End User’s records, 
systems and facilities, including machine IDs, serial numbers and related information, to verify that the use of any 
and all LICENSOR Materials is in conformance with this Agreement. End User will provide full cooperation to 
enable any such audit. If LICENSOR determines that End User’s use is not in conformity with this EULA, End 
User will obtain immediately and pay for a valid license to bring End User’s use into compliance with this EULA 
and other applicable terms and pay the reasonable costs of the audit. In addition to such payment rights, 
LICENSOR reserves the right to seek any other remedies available at law or in equity, whether under this 
Agreement or otherwise. 

Warranty 

THE PRODUCT IS PROVIDED "AS IS" WITH ALL FAULTS. TO THE MAXIMUM EXTENT PERMITTED BY LAW, 
LICENSOR HEREBY DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANITIBILITY, FITNESS FOR A PARTICULAR 
PURPOSE, AND WARRANTIES THAT THE PRODUCT IS FREE OF DEFECTS AND NON-INFRINGING, WITH 
REGARD TO THE SOFTWARE, AND THE ACCOMPANYING WRITTEN MATERIALS. YOU BEAR ENTIRE 
RISK AS TO SELECTING THE PRODUCT FOR YOUR PURPOSES AND AS TO THE QUALITY AND 
PERFORMANCE OF THE PRODUCT. THIS LIMITATION WILL APPLY NOTWITHSTANDING THE FAILURE OF 
ESSENTIAL PURPOSE OF ANY REMEDY. In any event, LICENSOR will not honor any warranty shown to exist 
for which inaccurate or incorrect identifying data has been provided to LICENSOR. The product(s) provided are 
intended for commercial use only and should not be utilized as the sole data source in clinical decisions as to 
levels of care.  
 
Furthermore, the Software Product may contain certain Cloud technology based features, such as messaging and 
crew view, where data can be passed freely between End Users using the Software Product. These features will 
generally be password protected, with no other built security for Software Product usage. Carlson accepts no 
responsibility for compromised data or loss due to unauthorized messaging or communication through Cloud 
technology provided in the Software Product.  

LIMITATION OF LIABILITY 

EXCEPT AS REQUIRED BY LAW, LICENSOR AND ITS DISTRIBUTORS, DIRECTORS, LICENSORS, 
CONTRIBUTORS AND AGENTS (COLLECTIVELY, THE "LICENSOR GROUP") WILL NOT BE LIABLE FOR 
ANY INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES ARISING OUT OF 
OR IN ANY WAY RELATING TO THIS EULA OR THE USE OF OR INABILITY TO USE THE PRODUCT, 
INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, LOST 
PROFITS, LOSS OF DATA, AND COMPUTER FAILURE OR MALFUNCTION, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF THE THEORY (CONTRACT, TORT OR 
OTHERWISE) UPON WHICH SUCH CLAIM IS BASED. THE LICENSOR GROUP'S COLLECTIVE LIABILITY 
UNDER THIS AGREEMENT WILL NOT EXCEED THE GREATER OF $500 (FIVE HUNDRED DOLLARS) AND 
THE FEES PAID BY YOU UNDER THIS LICENSE (IF ANY).  

Update Policy 

LICENSOR may, from time to time, revise the performance of its product(s) and in doing so, incur NO obligation 
to furnish such revisions to any End User nor shall it warrant or guarantee that any revision to the SOFTWARE 
will perform as expected by the End User on End User’s equipment. At LICENSOR's option, LICENSOR may 
provide such revisions to the End User.  

Customer Service 

Although it is the LICENSOR's customary practice to provide reasonable assistance and support in the use of its 
products to its customers, LICENSOR shall not be obligated to any End User to provide technical assistance or 
support through this Agreement and may at LICENSOR's sole election charge a fee for customer support. 
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Termination of End User License 

If any one or more of the provisions of this Agreement is breached, the license granted by this Agreement is 
hereby terminated. In the event of such termination, all rights of the LICENSOR shall remain in force and effect. 
Any protected health information data of End User maintained on LICENSOR’S data base shall upon reasonable 
notice to End User and at the discretion of LICENSOR may be destroyed. 

Copyright 

The SOFTWARE (including, but not limited to, any images, photographs, animations, video, audio, music and or 
text incorporated into the SOFTWARE), and all intellectual property rights associated with it, whether exists in a 
tangible media or in an electronic image media is owned by LICENSOR and is protected by United States 
copyright laws and international treaty provisions and all other commonwealth or national laws. LICENSOR 
reserves all intellectual property rights in the Products, except for the rights expressly granted in this Agreement. 
You may not remove or alter any trademark, logo, copyright or other proprietary notice in or on the Product. This 
license does not grant you any right to use the trademarks, service marks or logos of LICENSOR or its licensors. 
You may not copy any user documentation accompanying the SOFTWARE. 

Injunctive Relief 

It is understood and agreed that, notwithstanding any other provision of this Agreement, LICENSOR has the 
unequivocal right to obtain timely injunctive relief to protect the proprietary rights of LICENSOR. 

Entire Agreement 

This EULA constitutes the entire agreement between the parties and supersedes any prior agreements. This 
EULA may only be changed by mutual written consent. 

End User Agreement Acknowledgment 

The End User hereby accepts all the terms and conditions of this Agreement without exception, deletion, 
alteration. End User acknowledges they are authorized to enter this agreement on behalf of any organization for 
which the license is sought. Any unauthorized use of LICENSOR products will be considered a breach of this 
Agreement, subject to liquidated damages and otherwise unlawful and wilful infringement of LICENSOR's trade 
secrets and/or proprietary products. 

Payment and Refund Policy 

The use of the SOFTWARE herein is deemed a commercial use and under the terms of this license agreement 
End User shall not be entitled to any refund of purchase price. End User agrees to pay all user fees promptly. 
LICENSOR is authorized by End User to suspend any further access to SOFTWARE in the event fees are not 
fully paid. End user entity shall promptly pay any and all access and use charges incurred regardless of the end 
user. End user is responsible for protecting any pass word and user identity supplied to End User. 

Loss/Theft/Misuse 

End user shall promptly report to LICENSOR the theft or other loss of any password and/or user identity required 
to access SOFTWARE. LICENSOR shall not be responsible for maintaining the integrity of End User data in the 
event that end user’s data base is accessed and/or altered by an unauthorized end user due to the failure of 
licensed End User to protect its password or user identity. End User shall be responsible for any costs incurred by 
LICENSOR due to the negligence or reckless disregard of End User’s failure to protect its password or user 
identity. 

Civil/Criminal Investigation 

End user shall fully cooperate with LICENSOR and or any person authorized by LICENSOR (including local, 
state, or federal law enforcement officials) to investigate any alleged theft, misuse or unauthorized use of 
SOFTWARE or data related thereto. 
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U.S. Government Restricted Rights 

The SOFTWARE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (b)(1)(ii) and (c) of the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.  

Governing Law 

This EULA shall be governed and construed in accordance with the laws of the Commonwealth of Kentucky, 
USA.  


